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COPYRIGHT 

Copyright © CSi Italia Srl. 2006 -2020  

All rights reserved. 

 

The CSI Logo®, SAP2000®, ETABS®, SAFE®, are registered trademarks of Computers 

& Structures, Inc.  

Windows® is a registered trademark of the Microsoft Corporation.  

Adobe® and Acrobat® are registered trademarks of Adobe Systems Incorporated. 

 

The computer program VIS® and all associated documentation are proprietary and 

copyrighted products. Worldwide rights of ownership rest with CSi Italia Srl. 

Unlicensed use of these programs or reproduction of documentation in any form, 

without prior written authorizations from CSi Italia Srl., is explicitly prohibited. No 

part of this publication may be reproduced or distributed in any form or by any 

means, or stored in a database or retrieval system, without the prior explicit 

written permission of the publisher. 

 

Further information and copies of this documentation may be obtained from: 

CSi Italia Srl. 

http://vis.csi-italia.eu/ 

info@csi-italia.eu (for general information) 

support@csi-italia.eu (for technical support) 

  

http://vis.csi-italia.eu/
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DISCLAIMER 

Given the state of the art and the limits of computer science, CSi Italia cannot 

guarantee that the program and its manuals are entirely free of errors.  

 

Considerable time, effort and expense have been devoted to the development and 

testing of this software and the associated documentation, however, by choosing 

to make use of it, the user agrees and understands that no guarantee of the 

program accuracy and reliability is expressed or implied by the developer or 

distributor.  

 

The program is intended only to provide information to the user but not to replace 

him in his professional judgment. It is the user's responsibility to understand the 

basic assumptions of the software, compensate for aspects not addressed, and 

independently verify the results.  
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1. PART I: Introduction 

 

1.1. General 

VIS is a software suite for the design and check of concrete members:  beams, 

columns, walls piers and spandrels. The reference codes currently implemented 

are: 

• Current Eurocode1992:  EC2-2005 - Concrete design; 

• Current Eurocode 1998:  EC8-2005 - Seismic design. 

Four design areas are investigated: 

• strength: including PMM interaction, shear strength, slenderness;  

• capacity: including weak beam strong column action, shear capacity at columns, 

beams and joints, moment and shear magnification at walls; 

• serviceability: including stress limitation and cracking; 

• detailing provisions: including limits of reinforcement and of concrete geometry 

constraints, for both non-seismic and seismic conditions. 

The suite is made up of four separate programs, precisely: 

• Combinator, for the automatic generation of load combinations according to 

EC1 in SAP2000, ETABS and CSiBridge; 

• Section Cutter, for the automatic generation of Piers and Spandrels in SAP2000 

and CSiBridge; 

• VIS, the main program for the design and check of members; 

• SPF, an optional module for the automatic seismic evaluation of existing RC 

structures.  

 

 

1.2. Operation Modes  

Two autonomous operation modes are available for the program:   

• As a post-processor for SAP2000/ETABS/CSiBridge; 

• As a self-standing program. 

The two modes can be combined during a single work session.  

The post-processing mode is the preferred mode. 
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1.3. Use as a SAP2000/CSiBridge Post-Processor 

1.3.1. Installing VIS as a Plug-in 

VIS can function as a plug-in, directly from within SAP2000 or CSiBridge. The 

procedure is generally automated. If the auto install procedure succeeds, the VIS 

program will be listed among the plug-ins in the SAP2000/CSiBridge “Tools” menu.  

Certain conditions may require the plug-in to be installed manually. In such cases, 

proceed using one of the following two methods: 

• close SAP2000 and/or CSiBridge; 

• Launch the application “RegisterAll.bat” located inside the main installation 

folder of the VIS suite (typically C:\Program Files\CSI Italia). 

• As an alternative, to register the main program only, launch the application 

“RegisterPlugin.exe” that can be found inside the VIS installation folder. 

If the previous approaches did not work, it can be possible to manually register the 

plugin following these steps:  

• Run SAP2000/CSiBridge and enter the “Tools” menu; 

• Click on “Add/Show Plug-Ins…”; 

• From the installation window, enter the following: 

- On first column:  CSiItalia_VIS13; 

- On second column:  VIS 13;  

• Click the “Add” button. 

 

1.3.2. The SAP2000/CSiBridge Model 

In order for the SAP2000/CSiBridge model to be correctly imported and become a 

VIS model, certain criteria need to be followed: 

• the elements material to be imported needs to be of type “Concrete”. 

• Beams and columns need to be modelled with a single frame element per 

span/story. The variable reinforcing along the length of the elements will be 

defined directly in VIS.  

• The frame element sections can be defined through the parametric definition 

window (concrete rectangular, L, T and circle) or through section designer. In 

the latter case the sections should be made up by a unique polygon (with 

generic shape) and, optionally, a set of internal openings.  

• In order for a frame element to be recognized by VIS as a column, it needs to be 

vertical (parallel to the Z-axes). All other frame elements will be defined as 

beams. It will be always possible to convert elements from beam to column and 

vice versa using the command Define > Frame > Convert. 
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• Wall piers and spandrels need to be defined using shell elements having 

concrete materials. 

• The wall sections, which will be designed by VIS, are defined using 

SAP2000/CSiBridge Section Cuts. Typically, pier section cuts are taken at the top 

and bottom of each floor or (coupling beams) while spandrel sections at the 

two ends of the beam. Generation of the section cuts is facilitated by a separate 

plug-in tool called “Section Cutter”. Use of Section Cutter tool is explained in 

the following paragraph. 

 

1.3.3. Section Cutter 

Walls can be defined in the SAP2000/CSiBridge model using arrays of concrete shell 

elements. For the walls to be imported into the VIS model, they need to be 

preliminarily cut into a series of sections. These section cuts are taken at a finite 

number of locations along the length of the wall and organized into Wall-Stacks.  

The sections of each stack define the wall geometry (length, width, etc.) and 

internal forces. Depending on the geometry, the sections can be assigned either a 

“Pier” or “Spandrel” behavior. 

A section is given: 

• Pier behavior if the section’s normal axis has non zero vertical component;  

• Spandrel behavior if the section’s normal axis is horizontal. 

 

 

 

Within a single Wall-Stack, all section cuts need to be homogeneous, either Pier or 

Spandrel. If they are not, all cuts, whose type differs from the first, are discarded. 
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Being derived directly from the layout of imported shell elements, the geometry of 

wall sections cannot be modified by the user, once imported into in the VIS model 

and therefore would need to be rerun from the original import if incorrect.  

From a modeling perspective a wall can have a generic shape, however its design 

sections (section cuts) must be represented by a connected polygon. Therefore, 

whenever the layout of the wall openings determinates the formation of 

disconnected parts, it will be necessary to create different walls for each 

independent portion through “Section Cutter”. 

The “Section Cutter” tool provides a set of built in functionalities which can help 

the user in creating section cuts inside the structural mesh. This tool can be run 

directly through the SAP2000/CSiBridge “Tools” menu. If, after the installation of 

the VIS suite, the plugin is not visible, run the “RegisterPlugin.exe” application 

located in the Section Cutter installation folder. 

The program offers three different operational approaches: 

• Define vertical wall – automatic creation of wall piers from a selection of shell 

elements;  

• Define coupling beam – automatic creation of wall spandrels from a selection of 

shell elements; 

• Define section cuts – automatic creation of section cuts from 

SAP2000/CSiBridge’s groups. 

 

 

 

Define vertical wall 

This command allows to define a set of piers starting from a selection of shell 

elements. 

At this purpose it is necessary to select the shell elements which make up the wall 

and click on the corresponding command. It will then be possible to assign a name 
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to the wall (which must not include the symbol “_”) and identify the section cuts to 

be created. Section Cutter automatically creates section cuts at every grid plane in 

the Z direction. It is also possible to create additional sections at different 

elevations by simply selecting one or more joints corresponding to that elevation 

and activating the option "At selected Joints". For composite piers, with more than 

one leg, it is also possible to select the approach to be used for shear design: by 

activating the option “Create separate legs for shear check” the program will create 

additional section cuts for each leg of the wall while, on the contrary, the design 

will be based on the global forces of whole section. For more information, please 

refer to the corresponding section of the VIS Design Manual. 

Click the "OK" button to create the corresponding section cuts. A summary window 

will finally report the result of the operation showing potential errors occurred 

during the process. 

 

 

 

Define coupling beam 

This command allows to define a set of spandrels starting from a selection of shell 

elements. 

At this purpose it is necessary to select the shell elements which make up the 

coupling beam and click on the corresponding command. It will then be possible to 

assign a name to the beam (which must not include the symbol “_”) and identify 
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the section cuts to be created. Section Cutter automatically creates section cuts at 

both ends of the beam. It is also possible to create additional sections at different 

stations along the beam by simply selecting one or more joints corresponding to 

that location and activating the option "At selected Joints". 

Click the "OK" button to create the corresponding section cuts. A summary window 

will finally report the result of the operation showing potential errors occurred 

during the process. 

 

 

 

Define section cuts 

Use this form to generate section cuts based on "Groups" previously defined within 

SAP2000/CSiBridge. 

In order for the section cuts to be recognized and imported by VIS, they need to be 

defined into the model using groups containing nodes and elements and defined 

according to specific rules. Precisely: 

• Section cut groups should include all the joints along the cut line plus all of the 

elements on either side of the section. The joints define the cut location and the 

elements define the side of the section cut to which the internal forces refer. This 
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could be significant at floor lines or other discontinuous locations where the wall 

internal forces on either side are different; 

• Groups could come in any number along the length of the pier or spandrel. Their 

number and location should be chosen by the user to maximize information on wall 

behavior: e.g. at both sides of discontinuous lines; 

• Ideally, pier section cut groups should come in pairs, taken at any given level, just 

above and below the floor line. In order to do this, each section cut group should 

include the floor line and all the elements below, or all the elements above, 

depending on whether the section is a top or bottom section for the pier at that 

level; Spandrel section cut groups could be many, counting at least one at each end 

of the spandrel. 

• In order to build Wall-Stacks, the groups should be named by the user using the 

following syntax: 

WALL STACK ID _ PROGRESSIVE NUMBER 

“WALL STACK ID” refers to the name given to the pier or spandrel being defined 

and should not include the symbol “_”, while “PROGRESSIVE NUMBER” specifically 

defines the section cut along the Wall-Stack. Within a certain pier or spandrel the 

Wall-Stack ID should remain the same, while the number should vary with each 

section. It is suggested that the numbers are assigned in a consecutive fashion, 

increasing from the bottom up or from one side to the other. An alphanumeric 

string could be attached at the end: e.g. “Wall1_3Top” could be used to identify a 

section cut taken at the top of the third floor of wall 1. 

Click the "OK" button to convert all available groups into Section Cuts. A summary 

window will finally report the result of the operation showing potential errors 

occurred during the process. 

If not all groups need to be converted, select those to be excluded and press the 

"CANC" button from the keyboard. 

To overwrite previously defined Section Cuts, click the "Section Cut Overwrite" 

selection box. 
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1.3.4. Import  

To import the model from SAP2000/CSiBridge to VIS adhere to the following steps: 

1. Open SAP2000/CSiBridge and run the analysis; 

2. Start VIS from the “Tool” menu; 

3. Choose the load patterns and combinations you wish to design for. 

 

1.3.5. Design Process 

Once the model has been imported, proceed to the design and check of the various 

elements: 

1. From the toolbar in the lower right corner, select the units of preference. These 

settings can be changed at any time, as needed. 

2. From the “General Settings” tab, select the preferred code and the other 

relevant settings. 

3. From the “Wizard” tab, set the reinforcing preferences for beams, columns, 

piers and spandrels and click the “Run all” button. Once the design process is 

completed, look for potential error and warnings notified in the status bar of 

the program. Since the design process carried out by the Wizard is iterative, it 

can be possible that some or all the design errors reported have been resolved 

in subsequent iterations. For this reason, detailed checks must be performed as 

described at point 4. 

4. Run the checks for the different limit states using the command “Frames all” 

and “Walls all” of the “Strength”, “Capacity”, “Serviceability” and “Detailing 

provisions” tabs. 

5. From the “Results” tab, revise the D/C ratios for the different limit states either 

in a graphical or tabular form. If some elements do not meet some design 

requirement it is possible to look more in the details of the calculation simply by 

selecting the element and running the corresponding commands inside the 

“Strength”, “Capacity”, “Serviceability” or “Detailing provisions” tab. 

6. Use the “Edit > Segments > Edit reinforcing” command to look at and modify the 

reinforcing assigned to beams and columns. In the same way revise and edit the 

walls reinforcing using the “Edit > Wall reinforcing > Edit reinforcing” command. 

Inside both the environments all the checks can be easily re-executed in order 

to evaluate the effectiveness of the changes made.  

7. Once the revision of the reinforcing has been completed run again the collective 

checks for all the different limit states as described at point 4. 

8. Once the final result has been determined create the calculation report through 

the “Results > Report > Create” command. It is also possible to export the 

detailed reinforcing layouts for the different elements using the “Results > 

Reinforcing layout > Export” button. 
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1.3.6. Partial Import 

Importing from SAP2000/CSiBridge can include the entire model, or just a portion 

of the model. This option can be useful in containing the size of the portion of 

structure being designed when the model is significantly large. 

To do a partial import, while still working with SAP2000/CSiBridge, a “Selection” of 

all the elements to be designed must be completed first, then start VIS from the 

SAP "Tool" menu. Then proceed with the import procedures defined in paragraph 

1.3.4. 

Partial import is currently available only for frame elements. To avoid the import of 

certain shell elements you can specify which area section should be skipped 

directly in the import settings window. 

 

1.3.7. Updating Imported Models 

If changes need to be made to the SAP2000/CSiBridge model and the existing VIS 

model needs to be updated consequently, follow this procedure: 

• save the VIS model corresponding to the previous revision and close the 

program;  

• modify the SAP/CSiBridge model as desired and start VIS again from the "Tool" 

menu; 

• import the model as a new VIS model, save the file, close the program and open 

the new file directly in VIS; 

• open the application menu and click the command “Import Reinforcing”, then 

select the model corresponding to the previous revision as source model;  

• the reinforcing of all the members that did not undergo to geometrical changes 

will then be imported; 

• set the code preferences from the General Settings tab. 

With such approach it will be possible to handle any change to the structural model 

without losing the reinforcing layout assigned to the elements that have not been 

modified from one revision to another. 

 

 

1.4. Use as ETABS Post-Processor 

1.4.1. Installing VIS as a Plug-in 

VIS can function as a plug-in, directly from within ETABS (from v16.0.0). The 

procedure is generally automated. If the auto install procedure succeeds, the VIS 

program will be listed among the plug-ins in the ETABS “Tools” menu.  
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Certain conditions may require the plug-in to be installed manually. In such cases, 

proceed using one of the following two methods: 

• Close SAP2000 and/or CSiBridge; 

• Launch the application “RegisterAll.bat” located inside the main installation 

folder of the VIS suite (typically C:\Program Files\CSI Italia). 

• As an alternative, to register the main program only, launch the application 

“RegisterPlugin.exe” that can be found inside the VIS installation folder. 

If the previous approaches did not work, it can be possible to manually register the 

plugin following these steps:  

• Run ETABS and enter the “Tools” menu; 

• Click on “Add/Show Plug-Ins…”; 

• From the installation window, enter the following: 

- On the “Plugin Name” column:  CSiItalia_VIS13; 

- On the “Menu Text” column:  VIS 13;  

• Click the “Add” button. 

 

1.4.2. The ETABS Model 

In order for the ETABS model to be correctly imported and become a VIS model, 

certain criteria need to be followed: 

• The elements material to be imported needs to be of type “Concrete”. 

• Beams and columns need to be modelled with a single frame element per 

span/story. 

• The frame element sections can be defined through the parametric definition 

window (concrete rectangular, L, T and circle) or through section designer. In 

the latter case generic polygonal sections are not handled. If a certain section is 

not recognized during the import, VIS will still import the related member and 

will assign it a generic section shape. In this way it will be straightforward to re-

define the real geometry in the VIS program.  

• In order for a frame element to be recognized by VIS as a column, it needs to be 

vertical (parallel to the Z-axes). All other frame elements will be regarded as 

beams. It will be always possible to convert elements from beam to column and 

vice versa using the command Define > Frame > Convert. 

• Wall piers and spandrels need to be defined in the ETABS model using wall 

elements and appropriate piers/spandrel labels. Typically, the same label 

should be used from the bottom story to the top story of continuous piers: VIS 

will then automatically organize the different sections by elevation inside the 

same wall stack. Also, spandrel which couple different story of the same piers 

can have the same label: VIS will create a different coupling beams for each 

story. 
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From a modeling perspective a wall can have a generic shape, however its design 

sections (“Pier labels” and “Spandrel labels”) must be represented by a connected 

polygon. Therefore, whenever the layout of the wall openings determinates the 

formation of disconnected parts, it will be necessary to create different 

“Pier/Spandrel labels” for each independent portion. 

 

1.4.3. Import, design and updating of models 

For the import, design and updating of models please refer to §1.3.4, 1.3.5 and 

1.3.7. 

 

 

1.5. Use as Self-Standing Program 

VIS can be used autonomously to design and check single sections or very small 

models. Walls can only be imported from SAP2000/ETABS/CSiBridge. 

• Open VIS by itself using the executable icon from the computer desktop (or 

where it has been saved) or through the VIS directory. Set current codes and 

materials from the proper ribbon tabs and set the current units from the 

selector button on the right side of tool bar.  

• From the "Define" tab:  

- click the "Joints" button to define structural nodes;  

- click the "Sections" button to define sections;  

- click the "Frames" button to insert frame elements (columns and beams), 

assigning their end joints, their section and the number of segments they 

need to be divided into;  

- click the "Forces" button, to assign a set of internal forces. For each 

segment, specify, as required, several sets of forces deriving from various 

load combinations.  

• Complete the above for all of the structural members to be designed. 

• For design and check, follow the instructions previously provided in paragraph 

1.3.5. 

 

 

1.6. Combinator 

Combinator is a plug-in application for the generation of load combinations sets 

based on Eurocodes provisions. The tool can be run directly from the 

SAP2000/ETABS/CSiBridge “Tools” menu. If, after the installation of the VIS suite, 
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the plugin is not visible, run the “RegisterPlugin.exe” application located in the 

Combinator installation folder. 

The workflow is very simple: 

• While working with SAP2000/ETABS/CSiBridge, define the desired load 

cases. 

• Open Combinator from the “Tools” menu (in CSiBridge remember to 

execute Combinator within the “menu” interface and not within the 

“ribbon” interface). 

• Assign to each load case or combination the proper type and category, as 

defined in EC-1. 

 

 

 

• Set the filters deemed adequate to limit the number of combinations. 

Meaningless or redundant combinations should be avoided, to reduce 

calculation time and improve clarity. 
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• Select the Limit States for which the Combinations should be generated. 

These are the reference limit states from EC- 0. Precisely: 

 

STR Structural (non Seismic) ULS 

QKE Seismic ULS 

EQU Equilibrium ULS 

GEO Geotechnical ULS 

CHR Characteristic SLS 

FRQ Frequent Service SLS 

QPR Quasi-Permanent SLS 

 

 

More Limit States can be selected at the same time. 

 

• Select the summation mode. Either Linear or Range add. This is intended 

for checkered live load patterns. See SAP/ETABS User Manual. Range add 

combinations can be applied to all Loads Patterns having the same type. 

 

 
 

 

• Review the results, from the combination spreadsheet, and edit where 

required. 
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• Click the OK button to save the combinations and return to 

SAP2000/ETABS/CSiBridge. All the combinations are now included into 

the model and can be viewed from the Define > Load Combinations 

window. 
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2. PART II: Basic manual 

 

2.1. Columns and Beams  

Frame elements imported from the SAP model are treated by VIS as columns or as 

beams. By default, vertical elements are treated as columns and all other elements 

as beams. The user can change the default settings, as preferred, on an element-

by-element basis. The distinction between Columns and Beams has several 

implications. More precisely: 

• Strength design of Beams is carried out only for moment M3 and shear 

V2. Axial load should be null or very small. If not, an error message is 

reported. 

• For strength design, Beams are considered to have only top and bottom 

longitudinal reinforcing, plus vertical stirrups. 

• Strength design of double reinforced Beams can have infinite solutions. 

The result is made univocal assigning a steel target strain (default is 

0.005). 

• Beam checks do not have the previous limitations: biaxial bending and 

axial force are admitted and reinforcing can have any layout. 

• Strength design of Columns assumes the reinforcing design area to be 

uniformly distributed among all rebars. The rebar location needs to be set 

by the user. The default setting is one rebar at each corner. 

• Slenderness calculations are carried out for columns only. 

• The distinction between columns and beams necessarily affects all areas 

of capacity design calculations (weak beam - strong column design, shear 

capacity of columns and beams, shear capacity of joint panels). 

• The distinction between columns and beams also significantly affects 

various checks for code limits of reinforcing and geometrical provisions. 

 

 

2.2. Walls 

Walls can be defined in the SAP2000/ETABS/CSiBridge model using arrays of 

vertical concrete shell elements. For the walls to be imported into the VIS model, 

they need to be preliminarily cut into a series of sections either using “Section 

Cutter” (SAP and CSiBridge models) or assigning a proper “Pier” or “Spandrel” label 

(ETABS models). These section cuts are taken at a finite number of locations along 

the length of the wall and organized into Wall-Stacks.  
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2.3. Reference Systems 

The program utilizes the same reference systems used by SAP: there are global and 

local reference systems. All reference systems are right-handed. 

Global axes X, Y and Z define joint locations in the model global geometry. 

Element local axes, 1, 2 and 3, are used as a reference system for the element 

internal forces. 

Sections have principal axes as well. The principal axes for a given section, Major 

and Minor are those with maximum and minimum inertia. 

The picture below shows the sign convention used for local and principal axes, 

bending moments, radii of gyration and effective length. The local 1 axis is directed 

toward the observer. 

 

 

 

𝜌𝑚𝑎𝑗𝑜𝑟  radius of gyration (major axis) 

𝑒𝑚𝑎𝑗𝑜𝑟  eccentricity (major axis) 

𝐾𝑚𝑎𝑗𝑜𝑟  effective length factor (major axis) 

𝜆𝑚𝑎𝑗𝑜𝑟 =
𝐾𝑚𝑎𝑗𝑜𝑟 ∙ 𝑙

𝜌𝑚𝑎𝑗𝑜𝑟

 

With reference to the picture before: 

• Compression axial loads are negative; tension axial loads are positive.  
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• Positive bending moments cause compression at the positive face of the local 

axis.  

• Positive shear forces have the same direction of local axes. 

The effective length factors need be defined with reference to the principal axes. 

Conventionally 𝐾𝑚𝑎𝑗𝑜𝑟  refers to restraints acting on major axis moments, while  

𝐾𝑚𝑖𝑛𝑜𝑟  refers to restraints acting on minor axis moments.  

For slenderness calculations, the program converts the internal forces from the 

local to the principal axes reference system.  

 

2.3.1. Frame Section Reference Systems  

Frame sections can be viewed clicking on the “Frame” tab, at the lower right corner 

of the main window after a frame element is selected. Sections are represented in 

accordance with the following conventions: 

• Element local axis 1 is perpendicular to the section and points toward the user;  

• Element local axes 2 and 3 are oriented as in the SAP model, run through the 

section centroid, and can rotate as required; 

• There is also a section local coordinate system, used to identify the location of 

the installed rebar and vertexes. The x and y-axes are horizontal and vertical 

respectively and the origin is chosen by user. 

• The section upward direction, y, is parallel to the global Z-axis for beams, and 

parallel to the global X-axis for columns.  
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2.3.2. Wall Section Reference Systems 

If the model is imported from ETABS, the wall reference system match exactly the 

ETABS’s reference system; whereas if the model is imported from SAP2000 or 

CSiBridge, VIS automatically builds its own local reference system as described in 

the following paragraphs. 

There are two types of wall sections: pier sections and spandrel sections. The local 

reference systems of each have different conventions.  

 

Pier sections 

• The pier local axis 1 is parallel to the global Z-axis and points up;  

• The section is always perpendicular, with the pier local axis 1 pointing toward 

the user; 

• Axes 2 and 3 belong to the section plane and are oriented parallel or 

perpendicular to the section’s longer arm. Where: 

• if the longer arm falls within ± 45° from the global X axis, then the local 3 axis is 

parallel to that arm, otherwise it is perpendicular; 

• axis 3 points away from the positive global Y direction. If it is parallel to the 

global X axis, it points away from the   positive global X direction; 

• Axis 2 direction can be deduced applying the right hand rule, so that:  

V2 = V3 × V1 

 

Spandrel Sections 

• The section local axis 1 runs along the spandrel axes. It is parallel to the global 

XY   plane and points in the general direction of the positive global X axis. If 

parallel to Y, it points in the positive Y direction; 

• The section local axes 2 and 3 belong to the section plane and are parallel or 

perpendicular to the direction of the longer side of the spandrel section; 

• Axis 2 is set as follows: 

• the longer section side is identified and its angle with the Z axis is calculated; 

• if this angle is within ±45°, axis 2 is parallel to the longer side; otherwise axis 2 is 

perpendicular; 

• axis 2 direction is in the general direction of the positive global Z axis; 

• axis 3 is consequently defined using the right hand rule, so that  

V1 × V2 = V3 
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2.3.3. Examples 

Simple Wall Pier in the XZ Plane 

This pier has a simple, single leg section and is parallel to the global ZX plane. Loads 

are applied at top.  Where: 

Fx = -10 kN   Fy = +20 kN  Fz = +30 kN 

The control section is taken one meter below the top of the wall. Two section cuts 

are defined: one using the elements above the section line and one using the 

elements below the section line.  

The resulting internal forces are necessarily the same. Where: 

N = +30 kN 

V2 = +20 kN  M3 = +20 kNm 

V3 = +10 kN  M2 = +10 kNm 

 

 

 

Assembled Wall Pier 

Wall piers can also have complex sections. In this case, large wall assemblies, like 

elevator or staircases, can be treated as a single entity. The resultant of the 

external forces is calculated and applied at the centroid of the assembled section. 

The reinforcing is designed assuming the entire section remains planar and acts as 

that of a single pilaster.  
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User sensibility should limit this approach to relatively compact and slender wall 

assemblies. 

In this example, the pier section has three legs forming a C shape: the flanges are 

parallel to the global X-axis and the web is parallel to the global Y-axis.  

Note location and orientation of local axes and the global axes. 
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Wall Spandrel in the YZ Plane 

This spandrel is parallel to the global ZY plane and acts as a cantilever with applied 

loads at the free end.  

Where: 

Fy = +10 kN   Fx = -20 kN  Fz = +30 kN 

The control section is taken one and a half meters from the free end. 

Independently from which side of the section cut the group elements belong to, 

the resulting internal forces are: 

N = +10 kN 

V2 = +30 kN  M3 = +45 kNm 

V3 = +20 kN  M2 = +30 kNm 

 

Note that local axis 1 is now parallel to global axis Y 
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3. PART III: Reference manual 

 

3.1. Definitions 

• Frame Element:  any column or beam (independent from restraint 

conditions). Each frame is identified by a name, or frame ID. 

• Section: the concrete geometry and reinforcement layout of a frame or 

wall element. Each section is identified by a section ID. 

• Station: a point along the frame element with known internal forces and 

sections. Each station is identified by the frame local 1 coordinate. 

• Segment: a portion of frame element where the section (concrete 

geometry and its reinforcing) remains homogeneous. Segments along the 

frame element are identified by consecutively increasing numbers. A 

segment can include many stations. 

• Section Cut: a section cut done through a number of shell elements from 

the SAP model. At each cut the wall section geometry and internal forces 

are imported from SAP, the rebar layout is defined by the user in the VIS 

model. 

• Wall: a stack of wall sections having the same name and ordered by 

consecutively increasing numbers. 

• Pier: a wall element where the section cuts are not vertical. 

• Spandrel: a wall element where the section cuts are vertical. 

• Internal Forces: all the internal forces, namely N, M3, M2, V3, V2, which 

affect a given station for a given load combination.  

Note that the current VIS version does not support torsional moments. 

• Demand Capacity Ratio (D/C): ratio between code required performance 

and the calculated capacity of a given element, segment, section.  

• Design: the calculation of the minimum reinforcing required at each 

station to satisfy code requirements for a given load combination. 

• Check: the calculations for the verification of a given section, with 

reinforcing already assigned, to withstand code-requirements. Results are 

presented in the form of D/C ratios. A positive check requires the D/C 

ratio to be lower than one. Successful checks are typically presented in 

green, otherwise in red. 
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3.2. The Main Window 

The figure below shows the main window of the graphical user interface. The user 

can move or resize this window using standard operations.  

 

 

 

Five different areas can be identified: 

• Ribbon (1): the ribbon on the upper part of the main window includes all the 

program commands, organized in tabs and groups of commands according to a 

logical sequence; 

• Navigation Tab (2): the navigation tab, on the left side, allows the user to 

navigate among the various items of the model. These items are arranged into 

six categories: Joints, Sections, Columns, Beams, Walls, and Groups. The user 

can perform several operations on these various items, including select, edit, 

delete, and assign. Right clicking the mouse provides access to all available 

operations also; 

• Display Window (3): the display window, in the center, has three separate tabs 

which display the 3D model of the structure (“3D” tab) the internal segment 

subdivision of the selected frame element (“Frame” tab) or the internal section 

subdivision of the selected wall element (“Wall tab”). 

• Properties Tab (4): the tab on the right side of the main window provides useful 

information on the current selection. If more than one member is selected, the 

window reports the number of selected objects per type; while if only one 

member is selected the related detailed information are displayed (name, 

general and mechanical properties, commercial properties…). 

• Status Bar (5): the status bar, at the bottom, reports several information. In the 

left side the informational and error messages that can arise after the 

check/design phase are reported through an appropriate icon. With a simple 

2 3 4 

1 

5 
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click the related messages are displayed in a separate window. In right side the 

current code in use, the chosen ductility class, the coordinates of the cursor (if 

over an element section), and the units selector are displayed. 

 

3.2.1. The navigation tab 

The navigation tab organizes, by type, all the objects of the VIS model: 

• the “Joints” group includes all the “structural” joints of the model. A joint is 

considered “structural” when it is directly connected to a beam or a column or 

is part of a wall section cut. To select any joint click on the corresponding check 

box; the joint will be also highlighted in the 3D interface (please note that the 

wireframe view should be set in order to make joint objects visible). Right-click 

on the joint label to access the dedicated action menu which allows for several 

operations (reinforcing definition, restraint conditions…).  

• The “Sections” group includes, by type, all the sections defined in the model. If 

a single frame is selected, the section corresponding to the current segment is 

highlighted. Right-click on the section label to access the dedicated action menu 

which allows for several operations (editing, copying, duplication…). 

• The “Beams” group includes, by type, all the beams defined in the model. To 

select any beam click on the corresponding check box; the element will be also 

highlighted in the 3D interface. Right-click on the beam label to access the 

dedicated action menu which allows for several operations (reinforcing editing, 

internal forces definition…). 

• The “Columns” group includes, by type, all the columns defined in the model. 

To select any column click on the corresponding check box; the element will be 

also highlighted in the 3D interface. Right-click on the column label to access 

the dedicated action menu which allows for several operations (reinforcing 

editing, internal forces definition…). 

• The “Walls” group includes, by type, all the walls defined in the model. To select 

any wall click on the corresponding check box; the element will be also 

highlighted in the 3D interface. Right-click on the wall label to access the 

dedicated action menu which allows for several operations (reinforcing editing, 

internal forces definition…). 

• The “Groups” group includes all the groups defined in the model. Groups are a 

tool for memorizing complex multiple selections that the user can recall later, 

when these selections are needed again. Inside each group the objects are 

organized by type (beams, columns and walls). To select all the objects of a 

certain type click on the corresponding category. 
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3.2.2. Display window – 3D tab 

The 3D tab inside the main display window shows the full 3D view of the model and 

allows for a direct interaction with beams, columns, joints and walls. In the upper 

part of the tab a dedicated command panel is present. 

 

 

 

• The “Home” button restores the default view; 

• The “Magnifying glass” button activates the magnifying tool and allows for an 

instant magnification of the portion of the model under the cursor position. To 

exit the command click again on the corresponding icon. 

• The “Zoom window” button allows a direct zoom in a certain area through a 

rubber band selection. To exit the command click again on the corresponding 

icon. 

• The “Zoom” button activates the dynamic zoom mode. By holding the mouse 

button and moving the cursor it is possible to zoom on precise regions of the 

model. To exit the command click again on the corresponding icon. 

• The “Pan” button activates the pan mode. By holding the mouse button and 

moving the cursor it is possible to move the model over the graphical window. 

To exit the command click again on the corresponding icon. 

• The “Rotate” button allow to rotate the model by simply holding the mouse 

button and moving the cursor on the screen. To exit the command click again 

on the corresponding icon. 

• The “Zoom fit” command reset the zoom level so that the full model is visible 

maintaining the current viewpoint. To exit the command click again on the 

corresponding icon. 

There are also some shortcuts that allow to manipulate the model quickly: 

• to rotate the model place the cursor in a generic position of the 3D interface, 

press and hold the mouse wheel and move the cursor; 

• to perform a pan place the cursor in a generic position of the 3D interface, press 

and hold the mouse wheel and the ‘Ctrl’ button and move the cursor;  

• to zoom in a certain position place the cursor in the target region and then 

scroll the mouse wheel. 

The “view cube” in the right upper part of the window allows for a quick viewpoint 

selection (by clicking on a certain face, edge or corner) and for dynamic rotation (by 

pressing and holding the mouse button and moving the cube). 
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To select a certain frame or joint click on it or use the rubber band selection. To add 

elements to an existing selection press and hold the ‘Ctrl’ button. 

 

3.2.3. Display window – Frame tab 

Each frame object of the model is identified by a label which, for imported models, 

coincides with the one defined in the SAP2000/CSiBridge/ETABS model. Each frame 

can be divided into one or more segments, identified by a progressive number 

along the member. Each segment can have its own section and there are no 

particular limitations to their number or geometry. In this way it is possible to 

reproduce a generic reinforcing arrangement along the element. As we will see in 

the later paragraphs, the segment subdivision can be done manually by the user or 

automatically by the program using the specific editing environments. Segments 

are ordered starting from the frame initial joint (joint I). 

Managing the frames elements and the related segments through the graphical 

interface is rather easy: 

• to select a certain frame click on the corresponding check box in the navigation 

tab or click directly on the element in the 3D view of the model; 

• to navigate through the segments click on the “Frame” tab and use the 

dedicated selector in the upper part of the screen. A double click select the 

corresponding segment which will be highlighted in red. The name of the 

associated section is reported in the left upper part of the window and the 

corresponding geometry, local axes and reinforcing are shown in the center of 

the screen.  
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Within the “Frame” tab there are also some dedicated tools to customize the 

section reinforcing however, this is not the main purpose of this tab neither the 

recommended workflow. There are indeed other interactive and more productive 

tools, like the reinforcing editor, that allow for a detailed customization of the 

reinforcing of entire beam rows or column rows in fewer simple steps. All the 

different options are comprehensively described in 3.6.4. The “Frame” tab 

represents instead the primary tool to identify the internal layout of a certain 

frame and the related segments providing a prompt and exhaustive control over 

the model. 

Given the above, the editing tools are available through the “Frame tools – 

Reinforcing” tab that appears in the ribbon menu when the “Frame” tab is 

selected. The available commands vary from the possibility to quickly assign a 

section to a given segment, to the ability to customize its reinforcement. 

To assign a section to the current segment, right click on the section name inside 

the navigation tab and click “Assign”. The section can be selected among those 

with the same shape. 

To customize the reinforcing of the current segment there are two possible 

approaches: 

• global editing – that can be activated by selecting the “To all” button in the 

“Apply” tab of the “Frame Tools Reinforcing” ribbon menu. In this way all the 

changes applied through the quick editing commands, available on the right 

side of the tab or with a right click on the section draw, will be applied to all the 

segments across the model that shared the same section. 

• Local editing – that can be activated by selecting the “Locally” button in the 

“Apply” tab of the “Frame Tools Reinforcing” ribbon menu. In this way all the 

changes applied through the quick editing commands, available on the right 

side of the tab or with a right click on the section draw, will be applied only to 

the current segment. In the case the section was shared between more 

segments, VIS will automatically create a copy of the section with a new name 

and assign it to the current segment. For example, if the segment had an 

original section called “R30x40”, after the editing VIS will create and assign to 

the segment a new section called “R30x40-1”.  

Within the “Frame” tab it is also possible to view the coordinates of any point of 

the section polygon or longitudinal rebar by simply moving the mouse over the 

element: the corresponding coordinates will be reported in the lower right part of 

the “Status” bar. 
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3.2.4. Display window – Wall tab 

Each wall object of the model is identified by a label which, for SAP2000/CSiBridge 

models, coincides with the one defined through Section Cutter; while for ETABS 

models with the corresponding “Pier/Spandrel” label. A wall is made up by a set of 

associated “Section Cuts” organized by appropriate labels. 

Managing the walls and the related sections through the graphical interface is 

rather easy: 

• to select a certain wall click on the corresponding check box in the navigation 

tab; 

• to navigate through the sections click on the “Wall” tab and use the dedicated 

tree view in the left part of the screen. A single click select the corresponding 

section and the related geometry, local axes and reinforcing are shown in the 

center of the screen.  

 

 

 

Within the “Wall” tab there are also some dedicated tools to customize the section 

reinforcing however, this is not the main purpose of this tab neither the 

recommended workflow. There are indeed other interactive and more productive 

tools, like the reinforcing editor, that allow for a detailed customization of the 

reinforcing of entire walls in fewer simple steps. All the different options are 

comprehensively described in 3.6.5. The “Wall” tab represents instead the primary 

tool to identify the internal layout of a certain wall and the related sections 

providing a prompt and exhaustive control over the model. 

Given the above, the editing tools are available through the “Wall tools – 

Reinforcing” tab that appears in the ribbon menu when the “Wall” tab is selected. 

The available commands vary from the possibility to quickly assign a parametric 
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reinforcing to the current section to the possibility to customize in detail the 

reinforcing of the single legs. 

 

3.2.5. Properties tab 

The properties tab shows detailed tabular information on the current selection. If 

the current selection includes more than one element, the table reports the 

number of objects currently selected for each category (joints, beams, columns, 

piers and spandrels). When the current selection includes only one element, the 

table shows detailed information on it: 

• for a single joint element the general and reinforcing properties are displayed; 

• for a single frame element the general properties are reported along with the 

geometrical and commercial properties of the current segment; 

• for a single wall element the general properties are reported along with the 

geometrical (to show the subsection details click on the corresponding cell of 

the table) and commercial properties of the current section. 

 

 

3.3. The “Application” menu  

From the Application menu, identified by the           button, the user can:   

• start a new model; 

• open an existing model; 

• save the model in use; 

• export input and output data to Excel or XML files, already formatted for use on 

calculation reports; 

• import the reinforcing of selected beams, columns and walls from an existing 

VIS file; 

• check for program updates; 

• access user, design and verification manuals; 

• find information on program version and license; 

• select options such as language (English or Italian) and use of multithreading.  
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3.4. The “General Settings” Ribbon Tab 

This tab allows the user to choose the reference Code and to set general 

parameters, typically Code related. The tab includes the following groups of 

commands: 

• Code selection 

• General design settings; 

• Seismic design settings; 

• Serviceability design settings.  

 

 

 

3.4.1. Code Selection 

Presently implemented Codes are:  

• EC2-2005 / EC8-2005; 

• Italian NTC 2018 and related commentary; 

• Italian NTC 2008 and related commentary. 

For each code it is also possible to activate the “Seismic” option, in order to enforce 

the specific design and detailing requirements prescribed for structures in seismic 

areas. (Ref. Chapter 7 of NTC2008 and Chapter 5 of EC8). If the box is left 

unchecked, the requirements will be ignored by the program. 

 

3.4.2. General design parameters 

Use this tab to specify strength design settings to be used in the calculations. 

Default values for most of the design settings are preset by the program, based on 

the code of choice and generally accepted standards; however, they can be 

overwritten by the user, as required. 

The “General” tab includes: 

• Partial γ factors for materials:  these are the Eurocodes or NTC concrete and 

steel material partial factors. 
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• Concrete strength conversion: specify the conversion factor from cube to 

cylinder concrete strength. The default is 0.83. Alternatively select automatic 

conversion in accordance with EN 206-1. This command is active only when the 

Italian code is selected. 

• Steel target strain: specify the steel target strain for bending design of concrete 

beams. Note that this assignment applies to all rebars in the model. This target 

strain is used to make univocal the solution for double reinforced concrete 

beams. The default value of 0.005 is recommended for adequate beam ductile 

behavior. 

• Wall design settings: including the reinforcing cover, the preferred angle for 

potential inclined reinforcing, the maximum longitudinal reinforcing ratio and 

the preferences related to the design of non-critical sections. 

 

 

 

The “Bending” tab includes: 

• Maximum allowable strain: material ultimate strain values for reinforced 

concrete strength calculations. 

• Stress distribution assumption: either stress block or rectangle-parabola stress 

distribution. Note: the stress block method is faster; however, the rectangle-

parabola method is more accurate in case of sections not doubly-symmetric. 

• Stress parameters: assign the stress reduction factor α (long-term effects and 

unfavorable loading) and the stress block factor β (block height reduction). 

Note: some codes recommend using different α values depending upon the 

geometry of the concrete section, whether the width increases or decreases 
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starting from the compression face. This criterion cannot be applied to a 

complex model having different concrete sections and load combinations, and 

therefore it is generally recommended that the default (most conservative) 

value is used.   

 

 

 

The “Shear” tab allows to customize the shear strength mechanism. For those 

Codes using the variable angle Strut and Tie model, the strut inclination can be 

preset by user or calculated by the program. EC2-2005 and NTC2018/2008 allow a 

strut and tie model with variable inclination, where: 1 ≤ 𝑐𝑜𝑡(𝜃) ≤ 2.5. The 

program-calculated inclination is optimized at each location based on current 

reinforcing and code requirements. If the user assigns a preset inclination, this 

remains fixed at all locations. 
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Within the “Imperfections” tab it is possible to specify the value of the basic 

imperfection factor and other parameters which influence its value. If the effects of 

imperfections have already been included in the analysis, it is possible to avoid the 

calculation of additional moments by flagging the option “Already included in 

analysis”. 
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Within the “Second order” tab it is possible to specify the type of analysis that have 

been run choosing between three different options: 

• 1st order – select this option if only linear analysis have been run. Second order 

effects will be added to the moments using the effective length method. 

• 2nd order with P-Δ effects – select this option if non linear analysis considering 

global second order effects have been run. Local second order effects will be 

added to the analysis moments using the effective lengths lower or equal to 1. 

• 2nd order with P-Δ and P-δ effects – select this option if non linear analysis 

considering both global and local second order effects have been run. Analysis 

moments will not be further incremented. 

If the analysis is “1st order” or “2nd order with P-Δ effects” the user has the option 

to customize the parameters involved in the calculation of the second order 

effects. 

 

 

 

3.4.3. Seismic design parameters 

This group of commands is used to enter Code parameters required to define 

structures in seismic zones. The commands are code sensitive. 

• Structural properties: select the structural behavior (dissipative or non-

dissipative) and the corresponding ductility class. Eurocodes Low ductility class 

prescriptions are met leaving the seismic zone box unchecked. 

• Shear wall capacity design: set the parameters related to the capacity design of 

primary seismic walls (behavior factor to be used in the shear magnification, the 
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related spectral accelerations and the if the structure is a Dual System 

structure). 

• Curvature ductility: enter this text box to specify the curvature ductility factors 

for local axes 2 and 3. These factors are used to check column confinement 

provisions on critical regions in accordance with EC8-2005 - paragraph 5.2.3.2 

and paragraph 5.2.3.4. 

• Capacity design of joints: select the approach for the shear capacity design of 

concrete beam-column joints. 

• Beam-column PMM capacity design: select how to distribute the longitudinal 

design reinforcing between the bottom and top column of a selected joint (for 

additional details see 3.9.1). 

 

 

 

3.4.4. Serviceability design Settings 

This group of commands is used to enter Code parameters pertaining to 

serviceability limit states design (Stress Limitation and Crack Control). The 

commands are code sensitive. 

Default values are preset by program based on conservative use of code provisions 

and generally accepted standards. 

• Es/Ec: enter this text box to specify the modular ratio of steel to concrete, for 

Stress Limitation design. 

• Crack control: (EC2 2005) - enter this pull down menu to specify the limit state 

of concern for crack control design (Decompression, Crack formation or Crack 

width).  

• Wlim: (EC2 2005) - this text box is used to specify the maximum allowable width 

(mm) of cracks if the limit state is crack width. 
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• k1: (EC2 2005) - this text box is used to specify the reduction coefficient to be 

applied to concrete characteristic strength for Stress Limitation design with 

characteristic load combinations. 

• k2: (EC2 2005) - this text box specifies the reduction coefficient to be applied to 

concrete characteristic strength for Stress Limitation design with quasi-

permanent load combinations. 

• k3: (EC2 2005) - this text box is used to specify the reduction coefficient to be 

applied to steel characteristic yield strength for Stress Limitation design with 

characteristic load combinations. 

• Crack Conditions: (NTC 2008) enter this pulldown menu to specify the 

environmental condition limit state of concern for crack control design 

(Ordinary, Aggressive, Highly aggressive) 

• Crack Reinforcing: (NTC 2008) enter this pulldown menu to specify the type of 

reinforcing in use for crack control design (Slightly sensitive, Sensitive). 

 

 

3.5. The “Define” Ribbon Tab 

The commands from this tab are used to define or modify default materials, 

objects, components, internal forces, and groups.  

Each button opens a dedicated window. Some have pull down lists of commands 

for specific members or components. 

 

 

 

3.5.1. Default Materials 

This group of commands is used to set the default materials to be assigned to new 

elements and to view the material properties.  

It is important to note that the materials selected here will be assigned by default 

to all elements defined thereafter, but will not affect existing elements. To change 

the material properties of existing elements use the command “Edit > Concrete”, or 

“Edit >Steel”, after the elements are selected. 

Also, note that elements imported from SAP2000 inherit the material properties 

defined there.  
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Concrete 

Typically, concrete is defined by selecting a concrete class. However, user defined 

concrete can be assigned based on strength: cylinder or cube. (For those countries 

where cube strength is used, the conversion factor from cube to cylinder strength 

can be defined from the “General Settings” ribbon). 

• Class: specify the Concrete Class to be assigned to all new members. This 

assignment does not affect previously defined or imported members. To modify 

the Concrete class of previously defined and imported members, use the 

command “Edit > Concrete > Class”. 

• Concrete strength: if the class specified above is “user”, assign here the desired 

strength.  

Note that the command is sensitive to the code in use: strength here is cylinder 

strength fck for Eurocodes and cube strength Rck for NTC. 

Details on concrete properties can be obtained by clicking on the "Property details" 

button, at the bottom right side of this group. This will provide the design values of 

strength and other mechanical properties associated with the selected concrete 

class. The properties depend upon the design Code currently in use. This 

information is useful to understand the parameters used by VIS during the design 

process. 

 

 

Steel 

These commands can be used to define the steel properties to be assigned to all 

reinforcing steel, modeled thereafter. Typically, these properties are defined 

selecting a steel grade. User defined steel can be assigned as well, based on yield 

stress.  
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• Grade: specify the steel grade to be assigned to all new reinforcing from a drop 

down list.  

Note that this assignment does not affect previously inserted rebar, including those 

imported from the SAP model. To modify the steel grade of previously inserted 

rebar, use the command "Edit > Steel > Grade". 

• fyk: if steel is user defined, specify the yield stress to be assigned to all new 

reinforcing here.  

Details on steel properties can be obtained by clicking the "Property details" 

button, at the bottom right side of this group of commands. This will provide design 

values of the mechanical properties of the selected steel grade. The properties are 

those used by the program during the design process and depend upon the design 

Code currently selected.   

 

 

 

3.5.2. Objects  

This group includes the definition of several design objects and their properties. 

Precisely: Joints, Sections, Frames, and Walls. 

Typically, objects imported from SAP2000 already have their properties assigned. 

Consequently, VIS does not have property assigning commands. In the (rare) case 

when new objects are defined, all their properties are assigned during the object 

definition. Properties can later be modified using the edit commands. 

 

Joints 

Use this button to: 

• add joints to the model; 

• rename joints; 

• modify joint locations (this applies only to user defined joints, not to joints 

imported from SAP2000). 
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Sections 

From this button, access a dedicated window used to define or edit Frame Sections. 

Editing here is global. In other words, a change applied to a given section is applied 

to all segments using a section with that name within the entire model. The 

available operations are: 

• Define 

• Modify 

• Replicate 

• Delete 

• Substitute 

Note that, after they are defined, sections can be rotated by applying a rotation to 

the corresponding frame element (like it is possible in SAP/CSiBridge/ETABS). In 

this way the variety of available types becomes much larger.  

To define a new section, first select a section type clicking on a suitable icon. This 

opens a dedicated window for the parametric input of section data. The section 

types are Generic, Rectangular, T section, L section, Circular 

To define a generic section, the user is required to provide the cartesian (x,y) 

coordinates of all vertexes and rebar. Any shape of section and number of vertexes 

are accepted and multiple holes can also be defined. The input for all other section 

types is much simpler, since only a few parameters are required.  

When defining/editing a section, the related reinforcing can also be created. 

Dedicated commands for the parametric definition of longitudinal and transverse 

reinforcing are present for each shape and, for a detailed customization of the 

layout, it is possible to access a more general reinforcing definition window (simple 

click on the edit button in the lower left part of the section draw).  

Shear design is implemented for all shapes but for generic sections the related 

equivalent dimensions should be manually specified. The values of effective 

longitudinal tensile reinforcing for the shear check of unreinforced elements (Asl2 

and Asl3) should be manually defined by the user (the default value is 0). 

To substitute a section with a different one, drag its icon and drop it over the other. 

Drag and drop is allowed only for sections belonging to the same type.  
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Frames 

From this button, access the frame manager window. This window is used to define 

or edit frame elements within the current model. The list of all columns and beams 

is reported in two separate tabs. Selecting any of these elements provides easy 

access to each for editing and other operations. For each element selected, the 

following commands are available: 

• Define: to define a new column or beam; 

• Edit: to open the edit window for the selected element; 

• Convert: to convert a column into a beam or a beam into a column; 

• Forces: to open the Internal Forces input table for the selected element; 

• Delete: to delete the selected element. 
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The cancel button allows undoing any of these operations. 

The “Define” button (as well as the Edit button) from the “Frame Manager” opens 

the element definition window. 

The column definition window is as follows. 
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• Name: column ID. 

• Rotation: this text box can be used to assign a rotation to the column section, 

(as in SAP). The default is zero. 

• i and J joints: the start and end joints of a column. 

• Section Type: these buttons filter the list of available sections, 

• Concrete fck: this text box overwrites the default concrete (cylinder) strength 

for this member. If the model is imported from SAP, the strength is derived 

from the SAP model. For new elements, the strength is that from the "Default 

Materials" command group, found in this tab. 

• K factors: this text box allows overwriting of the column K factors defining the 

column’s effective length along the section major and minor axes. The default 

value is auto, which means that the effective length factors will be calculated by 

the program. 

• Seismic bending: a dropdown list to allow the selection of column bending 

behavior, either single or double curvature. This behavior cannot be obtained 

from a response spectrum analysis, because of the indeterminate sign of 

results; however, the information is necessary for column slenderness 

calculations. When slenderness calculations are relevant, the user should look 

at the deformed shape of the first modes or that of an equivalent static analysis 

to evaluate the type of curvature to be expected. 

• Modify segments: this section is used to subdivide the column into separate 

"uniform reinforcing" segments and assign to each its own section, chosen from 

a list. 

• Insertion mode: the segment insertion mode, whether relative or absolute. If 

relative, simply input the desired number of equally spaced segments. If 

absolute, enter the length of each segment. 

• Section: a dropdown list with the model’s current column sections to be 

assigned to each segment. If desired, click the "Create..." button to define a 

new section after having selected section type first. 

• Number: the number of segments required. Click the "Subdivide" button to 

generate equal length segments. 

• Segments: enter this data table to edit section assignment or the length of each 

segment previously defined. 

• Column length: calculated by the program and based on end joint location.  

• Note: for proper design of slender columns, the columns imported from SAP 

need to include only a single frame element. 
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The beam definition window is as follows. 

 

 

 

• Name: beam ID; 

• Rotation: this text box can be used to assign a rotation to the beam section (as 

in SAP). The default is zero. 

• Concrete fck: this text box overwrites the default concrete (cylinder) strength 

for this member. If the model is imported from SAP, the strength is derived 

from the SAP model. For new elements, the strength is that from the "Default 

Materials" command group found in this tab. 

• i and j joints: the start and end joints of the beam. 

• Section Type: these buttons filter the available section types. 

• Modify segments: this section is used to subdivide the beam into separate 

"uniform reinforcing" segments and assign to each a section, chosen from a list. 

• Insertion mode: the segment insertion mode, whether relative or absolute. If 

relative, simply input the desired number of equally spaced segments. If 

absolute, enter the length of each segment. 

• Section: a dropdown list with available sections to be assigned to each segment. 

If desired, click the "Create..." button to define a new section after having 

selected a section type, first. 

• Beam span: overall beam length calculated by the program and based on end 

joints. 

• Number: number of segments required. Click the "Subdivide" button to 

generate equal length segments. 
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• Segments: data table to edit section assignments or length of segments 

previously defined. 

 

Walls properties 

From this button, access the walls manager window. This window is used to edit 

wall elements within the current model. The list of all piers and spandrels is 

reported in two separate tabs. Selecting any of these elements provides easy 

access to each for editing and other operations. For each element selected, the 

following commands are available: 

• Edit: to open the edit window for the selected element; 

• Forces: to open the Internal Forces input table for the selected element; 

• Delete: to delete the selected element. 

In addition, for pier type walls, the following additional commands are present: 

• Critical zone: allows to define the critical zone extension of the selected walls by 

specifying the limiting elevation or the total extension from the base; 

• Seismic type: allows to define if the selected walls should be designed as ductile 

walls or large lightly reinforced walls. 

 

 

 

The “Edit” button from the “Walls Manager” opens the element definition window. 
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The pier definition window is as follows. 

 

 

 

• Name: the name of the pier is reported on the title of the window; 

• Wall type: pier; 

• Large lightly reinforced: defines if the pier should be designed as large lightly 

reinforced wall as defined by the design code selected. This option is active only 

when the seismic option is active and the design code is set to EC or NTC; 

• Slenderness: defines if the wall is slender (h/l>2) or squat with reference to the 

seismic behavior; 

• Consider out of plane shear: this option activates or deactivates the shear 

check in the transverse direction of each leg which sometimes, especially in the 

case of composite wall stacks, can underestimate the true strength due to the 

presence of high tensile forces; 

• Second order (K factors): effective length factors along the two principal 

directions. For simple walls the default value is 1 in the major direction and 

h/h1 in the minor direction, where h is the total height of the wall and h1 is the 

height or the first story. For composite wall stacks the default value is 1 in both 

directions. 

• Total height: the total height of the wall measured from the lowest to the 

higher section cut; 

• Base story height: distance between the first two section cuts, used for the 

calculation of the default critical region height according to the selected code; 

• Critical region height: default value of the critical region height calculated 

according to the selected code. This value can be easily overwritten by editing 

the “Critical” column in the sections table; 
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• Sections table: summary table which reports the following basic property of the 

different sections of the pier; 

• Section: name of the section cut; 

• Number of legs: number of legs of the section; 

• Elevation: elevation of the section measured in the global coordinate system; 

• Rck/fck: cube or cylinder strength of the concrete of the section; 

• Critical: indicates if the section is inside the critical region. All the sections 

below the highest critical sections are automatically flagged as critical;  

• Use transverse reinforcement: defines the strength mechanism for the shear 

check in the transverse direction for simple walls. By default, the shear strength 

in the transverse direction is calculated as for unreinforced members. To 

consider the contribution of transverse ties users should check this option. 

The spandrel definition window is as follows. 

 

 

 

• Name: the name of the spandrel is reported on the title of the window; 

• Wall type: spandrel; 

• Slenderness: defines if the spandrel is slender (h/l>2) or squat with reference to 

the seismic behavior; 

• Total length: the total length of the wall measured from the nearest to the 

farthest section cut; 

• Sections table: summary table which reports the following basic property of the 

different sections of the spandrel; 

• Section: name of the section cut; 

• Number of legs: number of legs of the section; 
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• Station location: distance of the section from the origin of the spandrel; 

• Rck/fck: cube or cylinder strength of the concrete of the section. 

 

3.5.3. Internal Forces 

The command “Display” allows to review the internal forces for a selected element. 

A single frame or wall element needs to be selected first. 

Each set of internal forces shown on the “Frame Internal Forces” window refers to 

a separate station along the frame element and to a separate load combination or 

permutation. These sets of forces are grouped by segment: one group for each 

frame segment.  

Internal force sets are typically imported from SAP2000. However, they can be 

edited or defined directly by the user. Copy and paste is permitted. It is mandatory 

for the station coordinate to fall within the segment to which it belongs. 

 

The forces are also organized according to the Limit State of each combination. 

Precisely: 

ULS:  Ultimate Limit States - Fundamental and Seismic load combinations. 

The Seismic combination is identified by a check box in the "Seismic" 

column. If the check box is active, the load combination is considered 

by the program as a Seismic Life Saving load combination. If the box is 

unchecked, the combination is considered as a fundamental Ultimate 

Limit State combination, not seismic. 

CHR/SLS:  Serviceability Limit States - Rare load combinations. 

FRQ/SLS:  Serviceability Limit States - Frequent load combinations. 

QPR/SLS:  Serviceability Limit States - Quasi-permanent load combinations. 

 

Data are organized into a spreadsheet where each row refers to a set of forces. The 

columns have the following headings and meanings: 

• Station: station location referred to frame origin (i node). 

• Combination: load combination name. 

• Type: the sign of results from a response spectrum analysis is indeterminate. 

For each seismic load condition, eight permutations are obtained alternating 

positive and negative signs and combining the forces with those from other 

load conditions. Permutations are identified here by a number from 1 to 8. 

Design checks are run separately for each. 

• Nd, M3d, … V2d: Internal forces, one set for each station and load condition. 
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• Seismic: check box for ULS combinations. When checked the combination is to 

be treated as seismic Life Saving ULS, if unchecked as non-seismic fundamental 

ULS. 

 

 

 

The “Wall Internal Forces” window is organized according to the wall section cuts. 

On the left side, the navigation bar allows the user to move between the various 

section cuts of the wall. On the right side, the internal forces for the selected 

section are organized in a spreadsheet format. 

 

 

 

Click on the “Show diagram” button, on the lower left side of the window, to see 

the internal force diagrams for each load combination or for their envelope.  
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The “Redistribute” command allows Moment Redistribution to be applied to the 

bending moments of selected beams in accordance with the code of preference. 

The redistribution affects ULS bending moments from non-seismic design 

situations. It is applied to active selections only. If no selection is active, the 

redistribution is applied to all beams in the model. 

The user can specify the amount of moment redistribution to be applied as a 

percentage of the code maximum allowed. To do so, click on the “Advanced” 

button from the tab “Define”, group “Internal forces”. 

 

 

 

This operation is non additive. In other words, if the redistribution is applied more 

than once, it will always start again from the original moments imported from the 

analysis. Hence, to delete any redistribution, simply apply a new redistribution 

where the applied percentage is null. 
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3.5.4. Groups 

These commands are used to define groups of objects. The groups are used to 

facilitate selection at a later time and are made available from the navigation bar 

from the main window. To define a group, simply select the desired objects, write a 

name for the group, and click the “Create” button. Groups can eventually be 

deleted with the “Delete” button. 

 

 

3.6. The “Edit” Ribbon Tab 

The commands from this tab can only be used after one or more elements are 

selected. 

 

 

 

 

3.6.1. Concrete and Steel 

Material properties are typically inherited from the SAP model or assigned to each 

element from the default material definition.  

However, materials assigned to each element can be overwritten using the edit 

command from this ribbon tab, after one or more elements (beam, column or wall) 

are selected. The user can choose a predefined concrete class or steel grade or 

define them directly.  

This overwrite is assigned by clicking the apply button. 

 

3.6.2. Slenderness Factor 

This group of commands can be used to overwrite the slenderness factor K for one 

or more selected columns or wall piers. Slenderness factors are used for slender 

column design and need to be assigned for both principal directions. 
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3.6.3. Seismic Bending 

This group of commands can be used to overwrite the seismic bending behavior for 

one or more selected columns or wall, the choice being between single or double 

curvature. By default, columns imported from the SAP model are assigned a single 

curvature bending behavior (which is the most conservative assumption). The 

column bending behavior cannot be obtained from a response spectrum analysis, 

because of the undetermined sign of results; however, the information is necessary 

for column slenderness calculations. 

 

3.6.4. Segments 

This group of commands has been specifically designed to give users all the 

necessary tools to assign/edit the reinforcing of frame elements. The main possible 

workflows are essentially two: 

• manual subdivision of frame elements into a certain number of segments (“Split 

frames” command) and subsequent assignment of previously defined sections 

to each segment (“Assign sections” command). In this way it is possible to fully 

customize the internal structure of the selected frame elements and control the 

sections assignments. 

• Interactive definition and/or editing of reinforcing of entire beam rows or 

column rows (“Edit reinforcing” command). Using this approach it is possible to 

revise and modify both the longitudinal and transverse reinforcing of entire 

lines of beams/columns defining the position of each bar across the section and 

the corresponding extension. Users will not need to manually define the 

segments and the corresponding sections as the software will automatically 

create the internal subdivision of each frame basing on the defined reinforcing 

layout. Within the same environment it is also possible to update all the checks 

in real time and evaluate the effect of the applied changes. 

The two workflows introduced above are independent and the choice of which one 

to follow is essentially problem dependent: in certain cases the manual subdivision 

and assignment strategy is more effective, like for example in buildings with several 

modular elements (precast structures); in others the interactive editing is more 

productive, especially for continuous beam rows with variable reinforcing. 

Going into the details of the single commands, the function “Split frames” allow to 

internally subdivide the selected frames into a set of segments of variable length. It 

is possible to use a parametric subdivision, which allows for the quick creation of a 

certain number of segments, or a manual subdivision which allows for a detailed 

subdivision. 
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The “Assign sections” command allows to assign the desired section to the 

different segments of the selected frames. If the current selection includes 

elements with a different number of segments, the assign window will include a 

number of rows equal to the maximum number of segments in the selected 

elements. 
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The third, and last, command “Edit reinforcing” opens an interactive environment 

where the reinforcing of a selected line of beams or columns can be edited with 

extreme precision. For the command to be active, first select a frame element. The 

entire line, to which the selected element belongs, will be made available for 

editing. 

 

 

 

 

 

The editing environment includes five separate areas: 

1. Section area – This area displays the section of the selected column or beam. 

The section is cut at the present location of the Slider Bar on the elevation area. 

Click on the edit button, to edit both longitudinal and transverse reinforcing. 

1 

4 

3 

2 

5 
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The change applies to the rebars belonging to the segment of reinforcing where 

the slider is positioned. If a selection from the Elevation Area is active, the 

change applies to all selected stretches of reinforcing (some restrictions apply). 

 

 

 

2. Elevation area – The entire reinforcing belonging to the selected line of beams 

or columns is shown in detail. Either the longitudinal or the transverse 

reinforcing can be selected, by choosing the corresponding tab at the bottom of 

the window. A click of the mouse can be used to select a given portion of 

reinforcing. The dimensions of the selected reinforcing are shown in the 

dimension area. Press “Esc” to exit the selection. A right click on a certain 

longitudinal reinforcing line will open a dedicated window which allows for a 

quick variation of the number and diameter of the selected rebars. A diameter 

change is always possible while the variation of the number of rebars depends 

on the number of different diameters currently assigned to the frame row. VIS 

can handle the automatic redistribution of up to two different diameters. If the 

current number of diameters assigned is more than 2, the changes should be 

applied manually by defining the rebar location in the section area and drawing 

the extension in the dimension area. 

 

3. Dimension area – This area shows location and dimension of homogeneous 

stretches of reinforcing, to be edited. These stretches include one or more 

rebars that are homogeneous in length, spacing and size. Fist you need to select 

the rebars to be edited (from either the Elevation or the Section areas). 

Selection from the Elevation area will engage all homogeneous reinforcing at 

once. Selection from the Section area allows for engagement or disengagement 

of single rebars. Note that the dimensions shown refer to the effective 

calculation length. They do not include anchorage or splices. 

• To modify the extent of longitudinal or transverse reinforcing drag the grips 

at the end of each stretch of reinforcing. If two separate stretches touch, 

they become a single stretch. 
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• To create new rebars point at the desired location for the new stretch and 

left click at the beginning and the end. Helpful snaps are prearranged for 

this purpose. Alternatively use the mouse to select the starting point and 

direction and assign the length numerically, after pressing the “Tab” button. 

• To delete a stretch, select it with a left click of the mouse and press the 

“Canc” button.   

• Press “Esc” to exit the present stretch selection. 

 

4. Design checks area – This area shows the summary of results for all checks run 

on the frame element, at the location of the slider bar. The results are reported 

as D/C ratios for each Limit State. To open the detailed result window for a 

given Limit State, click on the desired Limit State summary report. Results are 

automatically deleted as soon as any change occurs in the reinforcing layout. To 

update the results click on the “Check” button in the section area. 

 

5. Color coded results line – This area is a color-coded graphic display of the 

results for the entire line of columns or beams. The results refer to limit state 

selected from the Design Checks area. If more than one limit state is selected, 

the color will correspond to the highest D/C among the selected. 

 

3.6.5. Walls reinforcing 

This group of commands has been specifically designed to give users all the 

necessary tools to assign/edit the reinforcing of wall elements. The main possible 

workflows are essentially two: 

• parametric reinforcing assignment to a selection of wall piers or spandrels 

(“Piers” or “Spandrels” command). In this way it is possible to define the full 

reinforcing to be assigned to certain sections of the current selection of wall 

elements. The command window will allow to select the elevation range (in the 

case of piers) or station range (in the case of spandrels) to which the reinforcing 

should be assigned. 

• Interactive definition and/or editing of reinforcing of an entire wall (“Edit 

reinforcing” command). Using this approach it is possible to revise and modify 

both the longitudinal, transverse and diagonal reinforcing of entire walls. 

Dedicated commands to copy the reinforcing among different levels are also 

present. Within the same environment it is also possible to update all the 

checks in real time and evaluate the effect of the applied changes. 

The two workflows introduced above are independent and the choice of which one 

to follow is essentially problem dependent: in certain cases the manual assignment 

strategy on more walls at a time is more effective, like for example in buildings with 
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several large walls with constant reinforcing; in others the interactive editing is 

more productive, especially for complex wall stacks with seismic detailing. 

Going into the details of the single commands, the functions “Piers” and 

“Spandrels” reinforcing allow to assign a parametric reinforcing to the current 

selection of elements. It is possible to specify the elevation or station range on 

which the assignment will be performed in order to allow for an easier variation 

over the height/length of the member. For pier type walls the input parameters 

are: 

• elevation range over which the reinforcing is to be applied; 

• cover; 

• yield stress of reinforcing bars; 

• number, diameter and spacing of longitudinal bars at ends and intersections. 

Leaving the default “auto” spacing the rebars will be placed at a distance equal 

to the thickness minus two times the cover; 

• diameter and spacing of the longitudinal bars in the internal regions; 

• diameter and spacing of shear reinforcing; 

• number of legs, diameter and spacing of transverse ties. 
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For spandrel type walls the input parameters are: 

• station range over which the reinforcing is to be applied; 

• cover; 

• yield stress of reinforcing bars; 

• number, diameter and spacing of longitudinal bars at ends and intersections. 

Leaving the default “auto” spacing the rebars will be placed at a distance equal 

to the thickness minus two times the cover; 

• diameter and spacing of the longitudinal bars in the internal regions; 

• diameter and spacing of shear reinforcing; 

• number of legs, diameter and spacing of transverse ties. 

 

 

 

The third, and last, command “Edit reinforcing” opens an interactive environment 

where the reinforcing of a selected wall can be edited with extreme precision. For 

the command to be active, first select a wall element. 
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The editing environment includes five separate areas: 

1. Section area – This area displays the section currently selected, if unique. If the 

current selection includes more than one section, or none, the area will remain 

empty. When a valid selection is active, this area provides a direct interaction 

with the reinforcing allowing for the selection of rebars and execution of the 

editing command available on the command panel (4). 

 

2. Cuts list – Ordered list of all the section cuts associated to the current wall. Click 

to select a certain section and view it in the section area.  To select more than 

one section, useful for example to paste a reference reinforcing to more 

sections in one session, hold the Ctrl button. 

 

3. 3D view box – In this area all the sections associated to the current wall are 

displayed in the model space. Possible overlapping sections (sections at the 

same elevation) are offset by a specified amount that can be set in the 

command panel. Sections can be selected with a simple click or with a rubber 

band selection. Zoom and pan operations can be performed exactly like in the 

main window of the program. When checks results are present, it is possible to 

plot the contours of the D/C ratios by simply checking the corresponding limit 

state in the checks box (5). If more than one limit state is selected, the color will 

correspond to the highest D/C among the selected. 

 

4. Command panel – This panel includes all the available commands for the 

selected wall. The group “Global commands” allows to perform the check of the 

entire wall (after the reinforcing of all the sections have been defined) and to 

4 

2 3 1 

5 
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copy and paste a certain reinforcing to other elevations/stations. At this 

purpose simply select the base section and click on “Copy reinforcement”. The 

reference section will be highlighted in red and to paste the reinforcing simply 

select the target sections and click on “Paste reinforcement”. 

The ”Reinforcement commands” group includes a set of global commands for 

the definition of the reinforcement of the current section. The “Parametric 

reinforcement” command allows for the definition of a complete parametric 

reinforcement with the same approach we saw previously for the manual 

assignment. The “Perimeter reinforcement” command allows instead for the 

definition of the longitudinal reinforcement along each edge of the section by 

specifying diameters and spacing or the total number of rebar. 

 

 
 

The “Diagonal reinforcement” command defines the optional diagonal 

reinforcing of each leg. 

 

 
 

The “Detailed reinforcement” command displays a summary window with all 

the reinforcement assignments of the current sections allowing for a detailed 

customization. It is possible to edit the table of the longitudinal rebars, to 

customize the shear and transverse reinforcing of each leg along with the 

corresponding diagonal reinforcing. When editing a certain leg click on the 

“Apply” button before switching to a different leg otherwise the assignments 
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will be lost. The “Delete reinforcement” command completely deletes the 

reinforcement assigned to the current section. 

 

 
 

The “Rebars commands” group includes a set of dedicated commands for the 

local editing of the section rebars like, for example, the creation of a set of bars 

along the line defined by two selected rebars, the moving/replication of the 

selected bars, the creation of a transverse tie between two selected bars or the 

deletion of the selected bars. All these commands are especially useful for a 

detailed customization of the initial parametric distribution and allow for a 

higher level of detail on the rebar placing. 

The “View” group allows to define the offset between overlapping sections, to 

show the global reference system of the wall in the 3D view box and the local 

axes of each leg in the section area. 

 

5. Checks area – This area shows the summary of results for all checks run on the 

current section of the wall element. The results are reported as D/C ratios for 

each Limit State. To open the detailed result window for a given Limit State, 
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click on the desired Limit State summary report. Results are automatically 

deleted as soon as any change occurs in the reinforcing layout. To update the 

results click on the “Check” button in the command panel. By checking the box 

beside any limit state the corresponding contours of D/C ratios over the 

different sections will be displayed in the 3D view. If more than one limit state is 

selected, the color will correspond to the highest D/C among the selected. 

 

3.6.6. Joints reinforcing 

With this command the user can assign a specific shear reinforcing to a group of 

selected beam-column joints. If a single joint is selected, it is also possible to select 

whether the joint’s geometry should be calculated according to the bottom column 

(default option) or the top column (if present). 

 

3.6.7. Seismic Relevance of Members 

With reference to seismic design, columns and beams are considered primary or 

secondary members. Seismic provisions and capacity design are applied to primary 

members only. By default, all members are assumed primary. 

 

3.6.8. Wall transverse shear 

This option allows to exclude the shear check in the weak direction of each leg of 

the selected walls.   

 

 

3.7. The “Design Wizard” Ribbon Tab 

The commands from this tab are used to run a preliminary design and assign to the 

entire structure (beams, columns and walls) a start up reinforcing.  

 

 

 

The reinforcing assigned here is explicitly defined:  number of rebars, size, location 

and spacing. Not just minimum required areas.  
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This process automatically divides all frame elements into segments and fills them 

with longitudinal and transverse reinforcing. Much consideration is given to rebar 

continuity among adjacent elements. 

The reinforcing thus obtained is designed to satisfy code provisions for Strength, 

and Capacity design and to meet Detailing provisions. Serviceability checks should 

be run independently, when required.  

Those locations, where a straightforward solution cannot be achieved, are left 

empty, waiting for direct user intervention. Incidents are signaled by proper 

warnings.  

It should be noted that there is an infinite number of solutions for the reinforcing 

layout to satisfy code requirements. The choice of reinforcement is very personal 

and the solution proposed here is just one among many: by no means the best.  

Consequently, this should be considered just as a preliminary design, to be used as 

a starting point from which to proceed with a more accurate definition of the final 

project. The remaining parts of the program are intended to assist the user in the 

reinforcing refinement phase, moving forward from draft to final definition and 

from there to the drawing phase. 

After the reinforcing layout is generated by the Design Wizard, the user should 

proceed and run general checks for all members and for all design areas of 

concern: Strength, Capacity, Detailing provisions and Serviceability, if required. This 

will fill the result tables of the entire structure with D/C ratios and other design 

information, providing a full assessment of the reinforcing obtained and 

highlighting possible areas of concern. From here, the user can carry on applying 

the changes deemed necessary on an element-by-element basis and running local 

design-check operations. 

 

3.7.1. Configuration parameters 

This group of commands can be used to force the Design Wizard to allow some 

extra safety to be added, supplementary to all other Code prescribed factors. This 

recognizing the finality of the results obtained here, where we are dealing with 

actual reinforcing, not just required areas. Without extra safety, this reinforcing 

would be the bare minimum allowed, which sometimes could be inappropriate.  

Some extra safety should be included at this level, as a minimum to account for 

poor judgment or approximations in the model, affecting the output from the 

analysis phase.  

The safety factors are applied to the required areas thus increasing the total 

amount of reinforcing proposed. The factors can be applied separately to 

longitudinal and transverse reinforcing; for each, the default value is 1.05.  
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It is also possible to decide whether to include or exclude code minimum areas 

when assigning the reinforcing to the elements. This option is currently 

implemented only for frame elements (beams and columns). 

 

3.7.2. Frames reinforcing parameters 

Preferences for the longitudinal and transverse reinforcing of beams and columns 

are assigned here. Cover values specified in this section are always referred to the 

centroid of the longitudinal rebars. 

For beam elements the reinforcing is divided into two groups, base and added 

reinforcement. The base reinforcement is typically continuous, while the added is 

not. The program will select and optimize rebar diameters, choosing from those 

assigned to each group. As an option, it is possible to force a symmetrical (with 

respect to the vertical axis of the beam) reinforcing layout in the beams. 

Typically, the base reinforcing will be assigned diameters larger than (or equal to) 

the diameters of the added reinforcing. The user can override this preference, 

checking the box at the lower left corner of the window. 

A distinction is also made between primary and secondary members. Seismic 

provisions and capacity design are not considered in the design of secondary 

members. Note that by default all members are assumed primary. To change the 

assignment to secondary, use the edit menu.  

The user is also given the option to increase the beams overall bottom reinforcing, 

applying an increase factor to the required area. This is done by some engineers to 

account for creep, shrinkage and other occurrences, which may reduce negative 

moments at supports. This increase should not be confused with the code defined 

“Moment Redistribution”, addressed with a specific command. 
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For column elements the user can select different diameters to be used for primary 

and secondary members. Conventionally, the column reinforcing is not allowed to 

decrease from one story to the previous however the user has the option to 

overwrite this behavior using the “Free column reinforcement” option. Splices are 

normally set at the bottom of the elements but splices at middle height are also 

available by activating the appropriate checkbox. 

 

 

 

Preferred diameters for frame transverse reinforcing can also be assigned here. 
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3.7.3. Walls reinforcing parameters 

Preferences for the longitudinal and transverse reinforcing of wall piers and 

spandrels are assigned here. Cover values specified in this section are always 

referred to the centroid of the longitudinal rebars. 

For Pier-type shear walls, in addition to the list of diameters, the user can also 

specify the target values of the vertical rebar spacing inside the boundary regions 

and the internal regions. These values are used by the program to determine the 

optimal diameter among those selected. Starting from the lower diameter of the 

list, VIS calculates the corresponding minimum spacing that would comply to the 

design requirements and compare it with the target value specified by the user; if 

the calculated spacing is equal or larger to the target then that diameter will be 

chosen, otherwise the software continues its search with the next diameter.    

It is also possible to customize the maximum spacing allowed between the rebars 

placed along the thickness of the wall. 
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For Spandrel-type shear walls the user can specify the number and the related 

diameter of the edge rebars (top and bottom continuous reinforcing).  

Longitudinal and transverse edge reinforcing can also be specified in terms of ideal 

step and list of diameters.   

 

 

 

3.7.4. Run 

This group of commands allows to start the execution of the Wizard. Once the 

process will be completed, the user must proceed to the check phase as described 

in the following paragraphs. 

 

 

3.8. The “Strength” Ribbon Tab 

Two separate modes can be used for “Strength” design calculations: “Design” and 

“Check”.  
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The design calculation mode provides the minimum required area of 

reinforcement, given concrete geometry and internal forces. 

The check calculation mode provides Demand Capacity ratios (D/C) after the 

reinforcing has been assigned. 

 

3.8.1. PMM Design of Single Frame Elements 

Reinforcing design of frame elements subject to biaxial bending and axial load, 

given concrete geometry and internal forces, can generate infinite results. To attain 

a unique solution, two separate strategies are used: one for columns and one for 

beams. 

For Column Design, VIS requires the location of all reinforcing bars to be known 

(user defined). The diameter is not needed. Having thus reduced the number of 

variables, the program can calculate the minimum amount of the reinforcing 

required to satisfy all strength conditions. The calculated area of reinforcing is the 

total area to be divided into equal parts among all reinforcing locations. The 

calculations are executed for all sets of internal forces and all stations within a 

given segment. The reported result is the worst possible for each segment. The 

minimum reinforcing area required by code is reported as well. 

 

 

 

For Beam Design, tyically, the exact location of each rebar is not needed (the only 

exception being  Generic Geometry beams). Following the traditional approach, all 

top reinforcing and botton reinforcing are considered as collapsed onto their 

centroids and the only information required is the top and bottom concrete covers 
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(referring to these centroids). Double reinforced beams have typically infinite 

solutions. The criteria adopted by the program to make the solution unique, is for 

the tensile reinforcement to reach a given steel target strain, and, consequently, to 

know the location of the neutral axis.  

The steel target strain is set by the user in the Strength Design Settings, within the 

“General Settings” ribbon tab. The default value is 0.05.  The lower is the strain, 

even if the solution may be more economical, and the less ductile is the section 

behaviour. For an optimal value, the suggestion from the Eurocodes  is to keep the 

neutral axis at about 40% of the effective depth. The corresponding target steel 

strain is about 5‰, thus the default value used by VIS. The ACI code requires that 

steel strain be at least 4‰.  

Once a beam is selected and the PMM strength design button is pressed, the Beam 

Design window pops up showing, for each beam segment, concrete cover, target 

steel strain, minimum top and bottom reinforcing areas as required by design and 

by code minimum limits. Covers and target strains can be edited. 

 

 

 

Generic Geometry beams require the precise coordinates of each rebar to be 

provided. The area calculated is the design minimum total reinforcing and needs to 

be divided into equal parts among all locations. Results are similar to those for 

columns. 

 

3.8.2. Shear Design of Single Frame Elements 

Contrary to the above, the design solution for shear reinforcing of a frame element 

is univocal. Output is the required area of shear reinforcing per unit length. Shear 

reinforcing is always assumed perpendicular to the frame direction (not diagonal) 

and results are provided for both local 2 and 3 directions. 

E.g. if the result for a beam section is 1.27 mm2/mm and the user intends the 

spacing to be 150mm, the required minimum shear reinforcing area would be 

1.27x150=190.5mm2 to be divided among all legs. A 12mm diameter stirrup, 

having two legs with a total area of 226mm2, satisfies the requirement.  



 

79 

 

Once the actual size and spacing of transverse reinforcing is selected, the user can 

assign it to the section and proceed evaluating other possible concerns, including 

capacity design, detailing limits, or effects of diagonal rebar.  

 

 

 

3.8.3. Design of Frame Elements All At Once 

The previous commands refer to the design of a single frame element. This 

command runs the design of all frame elements at once, both PMM and shear. 

The results are reported in the "Strength results tables". These results are provided 

for each segment of frame elements and are in the form of minimum required area 

for longitudinal and transverse reinforcing. Note that units are cm2 for longitudinal 

rebar and cm2/cm for transverse reinforcing. Columns and beams results are kept 

separate. 

In order to execute this command, the geometry of all sections, as well as the 

concrete cover for all beams and the rebar location for all columns should be 

preliminarily defined. In addition, K factors should be assigned to columns if 

different from 1.0. If the concrete section of any element is found not to be 

adequate, the reinforcing design for that element is not carried out and a warning 

is posted. 

 

3.8.4. PMM Design of a Single Wall 

This command allows to design the longitudinal reinforcing of wall piers or 

spandrels with reference to the analysis forces. For pier-type shear walls, it is 

possible to define the rebar cover, the maximum allowable reinforcing ratio and to 

select the design strategy for the non-critical sections (uniform reinforcing or 

concentrated at ends). 
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At the end of the design, user can review the extension of the boundary regions 

calculated by the program for each leg of the wall by clicking on the string below 

the column “Boundary regions length”. 

 

 

 

For spandrel-type walls it is possible to define the rebar cover and the maximum 

allowable reinforcing ratio. 
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3.8.5. Shear Design of a Single Wall 

This command allows to design the shear reinforcing of a pier- or spandrel-type 

shear wall with reference to the analysis forces. In some cases, on the basis of the 

selected design code and internal forces, a trial reinforcing must be preliminary 

assigned to all the sections of the wall in order to perform the design.  

In the case of pier-type walls the software will calculate, for each leg of the section, 

the requested horizontal and vertical reinforcing ratios and the potential diagonal 

reinforcing area necessary for the sliding check of the critical sections. 

 

 

 

For spandrel-type walls the program will report the requested shear reinforcing 

ratio or, if the case, the diagonal reinforcing area. 
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3.8.6. Design of Walls All At Once 

This command performs the design of the longitudinal and shear reinforcing of all 

the walls of the model (both piers- and spandrel-type) at once with reference to 

the analysis forces. The design parameters used in the calculations are those 

specified in the “General settings” tab. The design results are available through the 

“Results > Strength > Wall design” menu. 

 

 

 

3.8.7. PMM Check of Single Frame Elements 

After the reinforcing is assigned, the frame PMM check button can be used to open 

the strength check window for biaxial bending and axial compression of a selected 

frame element. Beams and columns are treated similarly, but columns have 

additional checks addressing imperfections and slenderness. 
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On the upper left side of the window, the user can move between the various 

segments of the element.  

Right below, a check table reports the internal forces for all load combinations and 

all stations within the chosen segment. Each row refers to a single set of internal 

forces: 𝑁, 𝑀3, and 𝑀2. The last cell reports the pertaining result. Results are in the 

form of Demand Capacity ratios.  

The force sets are those imported from SAP2000 or defined in the “Internal forces” 

table from the “Define” ribbon tab. Here, however, the user can try out different 

forces, if desired by filling up the “Force Check” text boxes below the spreadsheet. 

For each force set, the check results are printed green if satisfactory, red if not. 

Demand Capacity ratios are “radial”. They are calculated in the N, M2, M3 space on 

a segment from the origin, through the force, and to the surface of the interaction 

diagram.  

Once D/C ratios for all the internal forces are verified at a glance, the user can 

select those more interesting and generate interaction diagrams, either in the MM 

or MN planes. These are reported on the right side of the window. The planes are 

those through the selected force set. The segment for the calculation of the D/C 

ratio is represented as well. With a right click of the mouse over the diagram, 

information that is more detailed can be obtained.  

2D interaction diagrams for different planes, both horizontal and vertical, can be 

obtained clicking the “Plot” buttons. 
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Clicking the “Export” button, the graphic representation of 2D interaction diagrams 

can be exported in the EMF format (used by Microsoft Word and other software) as 

vector graphics images and later pasted onto calculation reports.   

The numerical values of 2D interaction diagrams can be copied and later pasted 

onto a spreadsheet for further use clicking the “Copy” button 

A full 3D representation of the interaction diagram can be obtained by clicking the 

“3D view” button. Points representing the various force sets are represented as 

well. The representation can be further refined, using tools recalled by the right 

click of the mouse.  

 

 

 
 
Columns 

Results for columns are different from those for beams, since they also need to 

include moments due to slenderness and geometric imperfections. For this reason, 

columns have generally two or three check tables instead of only one. Precisely: 

• Analysis: the design moments are those imported directly from analysis, 

without added or magnified moments. Checks are reported at each station and 

for each load combination. The table is the same as for beams. 

• Imperfections: the design moments are those from analysis with the added 

effect of imperfections (or minimum eccentricity, if worse). Checks are reported 

for each load combination and each station.  

• Slenderness: the design moment is the sum of the first order equivalent 

moment, including the effect of geometric imperfections and the second order 

moment. The table is reported only when applicable (i.e., column is slender). 

Checks refer to the entire column, since a single equivalent first order moment 

is used. Results are given for each load combination.  
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For the column to be acceptable, checks need to be satisfied by all reported tables. 

For practical purposes, the worst D/C result is reported for each table, near the 

table title tab. The worst result overall is reported for each segment, near the 

segment itself. 

 

Note the following: 

• The method used for slenderness calculations is based on nominal stiffness or 

nominal curvature method. 

• Columns are assumed loaded only at ends. 

• The axial load is assumed constant along the element (maximum value is used). 

• The section is assumed constant throughout the column. 

• For sway frames, the user should also select the proper bending mode under 

seismic actions, either single or double curvature. 

• Slenderness calculations are necessarily referred to the column Principal Axes of 

Inertia, major and minor. Thus, K factors, as defined from the “Edit” ribbon tab, 

are referred to the Principal Axes, not the local axes. See also paragraph 2.3 and 

paragraph 3.8.2. 

Detailed information on column checks can be obtained by clicking the button 

“Details” and opening the column checks window.  

This window has two tabs. The “Calculation data” tab has information on all data 

used for column slenderness and eccentricity calculations. The “Amplified 

Moments” tab reports the bending moments magnified with imperfections and 

second order effects.  

Note that all information here refers to the Principal, rather than the local axes (as 

in the previous window). 
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3.8.8. Shear Check of Single Frame Elements 

After the reinforcing is assigned, the frame V check button can be used to run a 

shear strength check for a selected frame element. The button is active only if the 

"Enable shear check" selection box is checked in the section properties definition 

form, for the section in use (see the "Define" ribbon tab). 

 Checks are based on the strut and tie method, with variable or fixed angle as set 

for by the user from the “General Settings” ribbon tab (Ref. paragraph 3.6.2). 

The result window is as shown below. On the upper part of the window, the frame 

element and its segments are represented. The user can select a segment by 

double clicking. The worst D/C result is reported below each segment. Detailed 

checks for the selected segment are reported over two similar tabs: one for each 

local direction. 
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For the verification of the shear resistance according to the Eurocode, the following 

symbols are used: 

VEd  Highest design value of the applied shear force for the selected segment  

VRd,c design shear resistance of the member without shear reinforcement  

VRd,max design value of the maximum shear force which can be sustained by  

 the member, limited by crushing of the compression struts  

VRd,s  design value of the shear force which can be sustained by the yielding 

 shear reinforcement 

The shear strength check for unreinforced sections, requires that VEd ≤ VRd; for 

reinforced section that VEd ≤ VRcd and VEd ≤ VRsd 

The lower part of the window shows the message “Section is adequate” (green) or 

“Section is not adequate” (red). In the latter case, the equation(s) not verified are 

shown. 

 

3.8.9. Checks of Frame Elements All At Once 

The previous commands refer to the check of a single frame element. This 

command runs the check of all frame elements at once, both PMM and shear. 

In order to execute this command, the geometry and reinforcing of all sections 

should be preliminarily defined. In addition, bending mode and K factors should be 

assigned to columns. 
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The results are reported in the "Strength results tables", from the “Results” ribbon 

tab. These results are provided for each segment of all columns and beams and are 

in the form of Demand Capacity ratios. Tables for beams and columns are kept 

separate. 

From the same tab, results can also be viewed graphically. Here Demand/ Capacity 

ratios are represented with a color coded graphic display of the structural model. 

Outputs from each limit state are kept separate. 

 

 

 

3.8.10. PMM Check of Single Wall-Stacks 

After the reinforcing is assigned, the button for wall PMM checks can be used for 

biaxial bending and axial compression strength checks for a selected Wall-stack.  

Checks are based on all combinations of applied internal forces, as derived from 

the analysis, and results are provided as Demand Capacity ratios for the selected 

Wall-stack section.  

Click the “Interaction diagrams” button to access the “Interaction diagram” window 

for the selected wall section. This is similar to the interaction diagram window for 

columns. 
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3.8.11. Shear Check of Single Wall-Stacks 

After the reinforcing is assigned, the wall V check button can be used to open the 

shear strength window for a selected Wall-stack.  

Checks are based on all combinations of applied shear and axial force, as derived 

from the analysis, and results are provided as Demand Capacity ratios for the 

selected Wall-stack section. If in a critical region, the section is checked also for 

sliding shear failure. Two results tables are provided, one for each local direction. 

For Eurocode design code, notation is as follows: 

 𝑽𝑬𝒅 Highest design value of the applied shear force for the 

 selected segment  

𝑽𝑹𝒅,𝒄 Design shear resistance of the member without shear 

 reinforcement  

𝑽𝑹𝒅,𝒎𝒂𝒙 Design value of the maximum shear force which can be 

 sustained by the member, limited by crushing of the 

 compression struts  

 𝑽𝑹𝒅,𝒔 Design value of the shear force which can be sustained by 

 the yielding shear reinforcement 

𝑽𝑹𝒅,𝑺 Design value of shear resistance against sliding 

𝑫/𝑪 = 𝑽𝑬𝒅/𝑽𝑹𝒅 Demand Capacity ratio for shear strength  
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𝑫/𝑪 = 𝒇(𝝆𝒗, 𝝆𝒉) Demand Capacity ratio for vertical and horizontal 

 reinforcement, when 𝛼𝑠 < 2.0 (see EC8 §5.5.3.4.3 Eqn. 5.39) 

𝑫/𝑪 = 𝟐 ∙ 𝑽𝑬𝒅/𝑽𝒊𝒅 Demand Capacity ratio at squat walls with inclined bars 

 

 

 

3.8.12. Checks of All Walls At Once 

The previous commands refer to the check of single Wall-stacks. This command 

runs the check of all walls at once, both PMM and shear. 

In order to execute this command, the geometry and reinforcing of all sections, 

should be preliminarily defined. The results are reported in the "Strength results 

tables" in the “Results” ribbon tab. These results are provided for each section of 

all Wall-stacks and are in the form of Demand Capacity ratios. PMM and shear 

tables are kept separate. 

From the same tab, results can also be viewed graphically. Here Demand/ Capacity 

ratios are represented with a color-coded graphic display of the structural model. 

Outputs from each limit state are kept separate. 

 

3.8.13. Joints check 

This command is active only when the code is set to Italian NTC 2018 and the 

structure has been defined as “existing structure”. In this case the principal stresses 

acting in the center of the selected joint pane will be calculated and compared with 

the admissible values allowed by the code. When the “Check all frames” command 

is run, the checks of all the joints will be performed as well and the corresponding 

results will be available in the Results > Strength > Joint Checks table. 
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3.9. The “Capacity” Ribbon Tab 

Capacity design is implemented only for EC2-2005 and NTC-2008. The following 

settings need to be initially assigned from the “General Settings” ribbon tab: 

• Desired code 

• Seismic design 

• Ductility class 

Furthermore, a preliminary layout of all concrete reinforcing needs to have been 

assigned based on strength considerations, before capacity design can be 

performed. This can be done by the user based on his experience or using the 

Wizard and the strength design tools. Only then, the design process can proceed 

and modify the reinforcement in accordance with capacity criteria.  
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3.9.1. Design for Strong-Column Weak-Beam Action at Single Joints 

Design and check of column reinforcing can be performed at each joint, based on 

strong-column weak-beam action. Reinforcing of columns is calculated from the 

actual reinforcing of beams; while beam reinforcing, as defined from preliminary 

design, should meet strength requirements. 

 

 

 

The chosen joint needs to be defined first, by selecting all elements framing into it. 

Once the joint is defined, the “Column PMM” button opens a window where the 

joint geometry is recalled. This window is common to both the design and check 

phases. 

Angles between beams and columns can be various, but columns need to be 

vertical and beams horizontal. There is no restriction on the number of beams. The 

rotation angles of all beams and of the upper column are reported with reference 

to axis 3 of the lower column. 

Click the design button for design results. Based on beam reinforcing, the program 

calculates the sum of resisting moments from all beams, which is then equated to 

the sum of the required column minimum resisting moments allowing for steel 

strain hardening factors. The inequality condition reads as follow: 

∑ 𝑀𝐶,𝑅𝑑 ≥ 𝛾𝑅𝑑 ∙ ∑ 𝑀𝑏,𝑅𝑑 

The total resisting moment required for top and bottom columns is thus obtained. 

To make the solution univocal, the column resisting moments are then assigned to 

each, according to the distribution rule selected in the “General settings > Seismic” 

tab. The possible choices are: 
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• automatic distribution proportional to the analysis moments. In this case, if the 

bending moments on the top and bottom faces of the joint have the same sign, 

all the strength is assigned to the bottom column while the resisting moment of 

the top column is summed together with those of the beams. 

• Fixed distribution, defined by the user as As,top/As,bot ratio. 

• Automatic distribution based on the area ratio calculated through the strength 

design of the top and bottom columns at joint faces (default option). 

Given the large number of load combinations, a cloud of possible results is 

obtained. The program subsequently calculates the minimum reinforcing area 

required to envelope all resisting moments thus defined, accounting for axial load 

as well. 

 

 

 

Output is the total required reinforcing for both top and bottom columns. The 

reinforcing area needs to be uniformly divided among all rebar, maintaining the 

rebar location originally assigned during preliminary design. 

 

3.9.2. Shear Design of Single Beam-Column Joints  

The “Joint V” button performs the joint shear capacity design. 

Output provides the minimum transverse reinforcing area to be placed within the 

panel zone, to meet the shear demand associated with the formation of plastic 

hinges at the beams entering the joint. Calculations account for column applied 

shear force and steel strain hardening.  

Preliminarily, the program checks the compression strut. If the concrete strength is 

not adequate, the program does not proceed and an error message is issued, 

suggesting an increase in the size of the column.  

If compression strut resistance is adequate, the program proceeds, designing the 

required transverse reinforcement with two separate methods: 
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Confined concrete: shear resistance is provided by confined concrete. Confinement 

reinforcing is designed accordingly.  

Tie action: shear resistance is provided by reinforcing, acting according to the strut, 

and tie model. Shear reinforcement is designed accordingly. 

 

 

 

Adequacy of just one of the two methods suffices. The user should consider only 

the more favorable of the two results. 

Result is the total cross sectional area of horizontal hoops and cross ties within the 

height of the entire joint. It is provided for each local direction.  

 

3.9.3. Shear Design of Single Frame Elements 

The Design Frame V button opens the shear design window. This window provides 

design of transverse reinforcing of columns and beams, in accordance with capacity 

design criteria set by codes.  

The design shear force acting at the end of the beam or column is obtained 

applying the capacity design rule to the member, i.e. applying to the member ends 

their resisting moments and obtaining the shear force, required by equilibrium, 

with allowance for steel strain hardening.  

𝑉𝐸𝑑 = 𝛾𝑅𝑑 ∙
𝑀𝐶,𝑅𝑑

𝑠 + 𝑀𝐶,𝑅𝑑
𝑖

𝑙
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At columns, the calculation of the end resisting moments keeps into account the 

acting axial force. At beams, the equilibrium calculations include the external loads 

applied along the beam, as derived from seismic load combinations.  

Note: design can be performed only after the longitudinal reinforcing is completely 

defined. 

Output is the required area of shear reinforcing per unit length of frame element. It 

refers to the total shear reinforcing area (sum of all legs), assumed to be 

perpendicular to the frame direction (not diagonal). The capacity design applied 

shear 𝑉𝐸𝑑  is reported as well. 

Results are provided for each segment. At columns, for both 2 and 3 local axes are 

addressed. 

 

 

 

3.9.4. Design of Frame Members All At Once 

The previous commands refer to the design of single members (columns, beams, 

joints). This command runs the design of all members at once. 

The results are reported in the "Capacity results" window from the “Results” ribbon 

tab. These results are organized in tables, where columns, beams, and joints are 

kept separate.  

Note that units are cm2 for longitudinal rebar and joint (total) transverse 

reinforcement, while cm2/cm for frame transverse reinforcing.  

In order to execute this command, it is required for the preliminary reinforcing of 

all members to be already assigned, based on strength criteria. Design results at 

some locations could possibly be not achievable because of inadequate concrete 

sections. In this case, results are left blank. 

3.9.5. PMM Design of a Single Wall 

This command allows to design the longitudinal reinforcing of a pier-type shear 

wall with reference to the amplified forces calculated according to the capacity 

design rules for the selected design code. 
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The design settings and the design output are very similar to those related to the 

corresponding PMM strength design window. 

 

 

 

3.9.6. Shear Design of a Single Wall 

This command allows to design the shear reinforcing of a pier- or spandrel-type 

shear wall with reference to the amplified forces calculated according to the 

capacity design rules for the selected design code. In some cases, on the basis of 

the selected design code and internal forces, a trial reinforcing must be preliminary 

assigned to all the sections of the wall in order to perform the design. 

The design settings and the design output are very similar to those related to the 

corresponding shear strength design window. 
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3.9.7. Design of Wall All At Once 

This command allows to design the longitudinal and shear reinforcing of all the 

walls in the model (both pier- and spandrel-type) with reference to the amplified 

forces calculated according to the capacity design rules for the selected design 

code. The design parameters used in the calculations are those specified in the 

“General settings” tab. The design results are available through the “Results > 

Capacity > Wall design” menu. 

 

 

 

3.9.8. Check for Strong-Column Weak-Beam Action at Single Joints 

In most common cases, beam-column intersections belong to planar frames and 

results are immediately understood. The general case, however, has beams framing 

into the joint from more directions (e.g. corner columns). If this happens, the 

results are more complex and need to be regarded in a three dimensional PMM 

space. 

The chosen joint needs to be defined first, by selecting all elements framing into it. 

Once the joint is defined, the “Column PMM” button opens a window where the 

joint geometry is recalled. This window is common to both the design and check 

phases. 

There can be varying angles between beams and columns, but columns need to be 

vertical and beams horizontal. Number of beams can be any. The rotation angles of 
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all beams and of the upper column are reported, with reference to axis 3 of the 

lower column. 

Click the check button to open two results windows: numerical and graphical. The 

MM interaction diagram of the sum of the resisting moments from the columns is 

compared with the MM interaction diagram of the sum of the resisting moments 

from the beams. This is done at minimum and maximum N locations. 

 

 

 

Numerical results: D/C ratios are provided at significant MM locations, namely at 

the vertexes of the beams interaction diagram. 

Graphical results:  the graphic representation of the columns sum (green) and the 

beams sum (red) interaction diagrams is superimposed. For the check to be 

satisfied, the beams diagram needs to be entirely encompassed by the columns 

diagram.  

 

3.9.9. Shear Check of Single Beam-Column Joints 

The “Joint V” button performs the joint shear capacity check, based on reinforcing 

previously assigned.  
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The program provides the calculated shear demand Vjhd for the two joint rotation 

cases (clockwise and anti-clockwise) and the two joint local directions. Based on 

this shear demand, Capacity ratios are calculated for the following: 

• Diagonal compression strut 

• Confinement reinforcement 

• Diagonal tension tie 

The check for diagonal tension reinforcement is performed only if confinement 

reinforcement does not meet demand. 

 

3.9.10. Shear Check of Single Frame Elements 

The Check Frame V button opens the shear check window. This window checks 

transverse reinforcing previously assigned to columns and beams, in accordance 

with capacity design criteria, set by code. See paragraph 3.12.3 for details.  

Results are provided for each segment. At columns, design is for both 2 and 3 local 

directions.  
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3.9.11. Checks of Frame Members All At Once 

The previous commands refer to the check of single members (columns, beams, 

joints). This command runs the checks of all members at once. 

Before checks can be run, reinforcement needs to be assigned to all members, 

based on capacity design criteria as well as strength.  

The results are reported in the "Capacity results" window from the “Results” ribbon 

tab. Results are reported in worksheet tables, as Demand Capacity ratios, from 

bending and shear reinforcing checks. Columns, beams, and joints are kept 

separate.  

From the same tab, results can also be viewed graphically. Here Demand/ Capacity 

ratios are represented with a color coded graphic display of the structural model. 

Outputs from each limit state are kept separate. 

 

3.9.12. PMM Check of Single Wall-Stacks 

The Check PMM wall button runs PMM checks for a selected Wall-stack and opens 

the capacity check resulting window. Results are provided as Demand Capacity 

ratios. 

Applied bending moments are vertically displaced, as required by code. At large 

walls, additional axial force is accounted for, where cracks or uplift may occur. 

Checks refer to all possible permutations of bending and axial forces. 
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Click the “Interaction diagrams” button to access the graphic display of the 

interaction diagrams for the Wall-stack section presently selected. This window is 

similar to that described for frame elements. 

Click the “Amplified diagrams” button to access a graphic display of the envelope 

diagram of amplified internal forces, N, M2 and M3, as distributed along the length 

of the wall.  

 

 

 

3.9.13. Shear Check of Single Wall-Stacks 

This command runs capacity shear checks for a selected Wall-stack and opens the 

resulting window.  
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Shear diagrams are amplified according to code specifications, based on ductility 

class, structural type (whether dual system or not), and structure behavior factor q.  

At large walls, the dynamic component of the axial force is accounted for, where 

cracks or uplift may occur. The additional axial force is added or subtracted. The 

resisting shear force is calculated accounting for the worst condition.  

Shear sliding checks are run at critical regions. 

Checks are performed for each local direction and results are provided as Demand 

Capacity ratios. 

Click the “Amplified diagrams” button to access a graphic display of the amplified 

shear forces envelope diagram, as distributed along the length of the wall. 
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3.9.14. Checks of All Walls At Once 

The previous commands refer to the check of single Wall-stacks. This command 

runs the checks of all walls at once, both PMM and shear.  

The results are reported in the "Capacity results tables" from the “Results” ribbon 

tab. These results are provided for each section of all Wall-stacks and are in the 

form of Demand Capacity ratios. PMM and shear tables are kept separate. 

From the same tab, results can also be viewed graphically. Here Demand/ Capacity 

ratios are represented with a color coded graphic display of the structural model. 

Outputs from each limit state are kept separate. 
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3.10. The “Serviceability” Ribbon Tab 

Codes have detailed provisions for three Serviceability Limit States: 

• Stress limitation 

• Crack control 

• Deflection control 

Of these, only the first two are addressed here. Deflection can be checked directly 

from SAP2000, being a direct result of the analysis. 

Serviceability provisions are supported only in “Check” mode. No design is directly 

available.  

 

 

 

3.10.1. Stress Limitation Checks of Single Frame Elements 

The button “Check stresses” is used to run stress checks for a selected frame 

element, under proper service load conditions. The ensuing window shows the 

service load combinations and the resulting concrete and steel stresses. These are 

compared with code limits and results are provided as Demand Capacity ratios. 

Calculations use the method of transformed section, with compression only 

concrete and linear stress strain relations. Sections are assumed to remain planar. 

The 𝑛 = 𝐸𝑠/𝐸𝑐 modular ratio of steel to concrete is specified from the “General 

Settings” ribbon tab. 

Checks are provided for all service load combinations at all stations within a given 

segment. The segment is chosen by the user clicking the desired location from the 

graphics on the upper part of the window. 

Additional load combinations can be assigned by the user, directly from this 

window. 
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3.10.2. Crack Control Check of Single Frame Elements 

The button “Check cracking” is used to run crack control checks for a selected 

frame element, under proper service load conditions. 

Based on EC2 provisions, the Service Limit States considered here are 

decompression, crack formation, and crack opening. The necessary code 

parameters are assigned from the “General Settings” ribbon tab.  

Commands and output are sensitive to the selected code. NTC has different limit 

states and settings based on environmental conditions and protection of 

reinforcing. 

Checks are provided for all proper service load combinations and at all stations 

within a given segment. The segment is chosen by the user clicking the desired 

location from the graphics on the upper part of the window. 

Additional load combinations can be assigned by the user directly from this 

window. 
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Demand Capacity ratios for each load combination are provided comparing crack 

openings with Wlim. 

 

3.10.3. Checks of All Frame Elements At Once 

The previous commands refer to the check of single frame elements. This 

command runs the check of all frames at once, for both Stress limitation and Crack 

control. In order to execute this command, the geometry and reinforcing of all 

sections should be preliminarily defined.  

The results are reported in the "Serviceability tables" from the “Results” ribbon tab. 

These results are provided for each segment of each frame element, while columns 

and beams tables are kept separate.  

From the same tab, results can also be viewed graphically. Here Demand/ Capacity 

ratios are represented with a color coded graphic display of the structural model. 

Outputs from each limit state are kept separate. 

 

 

3.11. The “Detailing provisions” Ribbon Tab 

The detailing provisions, considered here, refer to limits of reinforcing and to 

concrete geometrical constraints. These provisions derive from both the concrete 

and the seismic sections of the code. Referring to the Eurocodes in particular, 

detailing provisions are taken from EC2 and EC8. Detailing provisions are supported 

only in “Check” mode. No design is directly available.  
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3.11.1. Check of Single Frame Elements 

This command runs detailing provisions checks for a selected beam or column.  

Results are immediately reported on the “Detailing and limits of reinforcing” 

window. This window provides very detailed information on all provisions 

addressed and on reasons of failure, if any. The relevant code section is reported as 

well. A green, red, and yellow color code marks checks that passed, failed, or not 

applicable. 

Provisions refer to the following general topics: 

• concrete section minimum dimensions; 

• limits of longitudinal reinforcing, both minimum and maximum; 

• limits of transverse reinforcing, both minimum and maximum; 

• reinforcement ratios. 
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3.11.2. Check of Single Joints  

This button runs detailing provisions checks for a selected beam-column joint. 

The results are immediately reported on the “Detailing and limits of reinforcing” 

window. This window is similar to that previously described and provides very 

detailed information on all the provisions addressed and on the reasons of failure, 

if any. The relevant code section is reported as well. 

Provisions address the following general topics: 

• minimum longitudinal reinforcing; 

• minimum joint confinement reinforcing; 

• reinforcement ratios. 

 

3.11.3. Check of Single Walls 

This button runs detailing provisions checks for a selected Wall-stack. 

The results are immediately reported on the “Detailing and limits of reinforcement” 

window. This window provides very detailed information on all the provisions 

addressed and on the reasons of failure, if any. The relevant code section is 

reported as well. 

Provisions address the following general topics: 

• wall section minimum dimensions; 

• minimum longitudinal reinforcing; 

• minimum joint confinement reinforcing; 

• reinforcement ratios. 

 

3.11.4. Checks of All Frame Members At Once 

The button “Check all” is used to run a check of all frame elements and all frame 

joints at once. Results are reported in the “Detailing” provision section of the 

“Results” ribbon tab. 

 

 

3.12. The “Results” Ribbon Tab  

This tab provides organized results from the design and check phases previously 

performed.  
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The “Results” commands are prearranged in four groups: 

• Tables; 

• Diagrams; 

• Reinforcing layouts; 

• Report. 

All results can be exported for subsequent use on calculation reports.  

 

3.12.1. Strength Tables  

Strength design summaries for both design and check results are provided. Results 

are presented in spreadsheet format, with separate tables for beams, columns, 

joints and walls.  

Design results provide minimum required reinforcing areas, while check results 

provide Demand Capacity ratios. Only the worst case for each load combination is 

reported. 

Results for columns and beams are reported for each segment. Results for Wall-

stacks are reported for each section. If one or more members are selected, results 

are reported only for those. If no selection is active, results are reported for all 

members. 

 

3.12.2. Capacity Tables 

Capacity design summaries for both design and check results are provided. The 

results tables are similar to those described above. 

If one or more members are selected, results are reported only for those. If no 

selection is active, results are reported for all members. 
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3.12.3. Serviceability Tables  

Serviceability check results summaries are provided. Tables are similar to those 

described above. 

If one or more members are selected, results are reported only for those. If no 

selection is active, results are reported for all members. 

 

3.12.4. Detailing Provisions Tables 

This button provides summary tables of checks for detailing provisions. Results are 

presented as spreadsheets, with separate tables for beams, columns, joints and 

walls. Results for columns and beams are reported for each segment. Results for 

Wall-Stacks are reported for each section. 

 

 

 

Results are reported in a passed or not passed format base on the number of 

checks that are satisfactory overall. Results are printed in green if all checks passed, 

otherwise in red. If checks do not apply to a given instance, results are printed 

yellow. A double click over one of the results opens a window with the detailed 

results checklist, similar to that described for single element checks. 

If one or more members are selected, results are reported only for those. If no 

selection is active, results are reported for all members. 

For each frame element, other information is reported, such as section ID and 

length of all segments.  
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3.12.5. Log Table 

This command opens a table with a list of program-generated messages. The 

messages refer to errors or inconsistencies encountered during execution. 

 

3.12.6. Delete results 

This command deletes all the design and check results for all the elements of the 

model. 

 

3.12.7. Show ratios 

This command graphically displays the demand capacity ratios contours of frames 

and walls with reference to the selected limit states. 

Frame results can be displayed considering the worst D/C ratio over the entire 

length of the element or on a segment by segment basis. 

 

 

 

3.12.8.  PMM 3D Interaction Diagram 

This command opens a full 3D graphics with the PMM interaction diagram of the 

section selected on the main window. The representation can be further refined 

with tools recalled by the right click of the mouse. 
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3.12.9. Ellipse of Inertia 

This command opens a graphic window with the diagram of the ellipse of inertia for 

the section selected on the main window. The maximum and minimum radii of 

inertia are reported. 

  

3.12.10. Reinforcing layouts 

This group of commands allow to display and export in .dxf/.dwg format the 

reinforcing layouts of beams, columns and walls. 

The user can select a frame element and click on the “Display” command to 

visualize the reinforcing sketch of the selected beam or column. For columns, the 

user is required to select the preferred splicing location: either at the bottom or at 

mid-column. From the same window the user can export the single element or the 

layout of the entire beam or column row in .dxf/.dwg format. 
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If the user selects more than one frame or wall element, the corresponding beam 

and column rows and wall stacks can be directly exported in separated .dxf/.dwg 

files using the command “Export” of the ribbon menu. 

 

 

 

Alternatively, by clicking on “Export rebars table”, it will be possible to create 

detailed rebars tables of the selected beams and columns row. 

 

3.12.11. Report 

Through this command it is possible to generate an extensive report which contains 

the details of the calculations performed for each structural element. The report is 

generated in Word format.  

By clicking on the “Details” button, it would be possible to choose the units to be 

used in the document. 

 

 

3.13. The “View” Ribbon Tab 

Through this menu the user can customize the graphical preferences and navigate 

through 3D and 2D views. 

 

 

 

The menu is divided in the following groups: 
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• View type; 

• Set view; 

• Show/Hide; 

• Reinforcing contours. 

 

3.13.1. View type 

This group of commands allow the user to switch from extruded to wireframe view. 

In addition, by clicking on the “Advanced” button (beside the group’s name) the 

“View preferences” window will be shown. In this window the user can customize 

the colors and the size of the different elements. These settings are saved in the 

model file and maintained when the model is closed. To change the default color 

profile used when a new model is imported use the “Set color profile…” command. 

 

 

 

3.13.2. Set view 

These commands allow to switch in a plane view based on the local axes of the 

selected frame element. 
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3.13.3. Show/Hide 

These commands allow to display or remove different components from the 

current view (e.g. origin, labels…). 

 

3.13.4. Reinforcing contours 

These commands allow to display color-coded views of the entire model related to 

the reinforcing currently assigned to beams and columns. The following contour 

maps are available: 

• columns longitudinal reinforcing ratios; 

• beams top longitudinal reinforcing ratios; 

• beams bottom longitudinal reinforcing ratios; 

• longitudinal reinforcing densities on beams and columns; 

• shear reinforcing densities on beams and columns; 

• total reinforcing densities on beams and columns. 

 

 

 

 

3.14. Additional export capabilities 

The following results can be exported for use on calculation reports: 

 

Summary of Results 

tables for Strength, 

Capacity, 

These tables can be obtained from the “Results” ribbon 

tab and can be exported to Excel spreadsheets using the 

corresponding button on the top of the table. These 
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Serviceability and 

Detailing provisions 

 

tables are kept updated while the user runs additional 

design/checks. 

Design tables provide minimum design areas for 

longitudinal and transverse reinforcing.  

Check tables provide Demand Capacity ratios from PMM 

and V checks of worst load conditions for all members, 

including frame segments, wall sections, and beam-

column joints. 

Frame internal 

forces tables 

Internal forces tables for each frame element can be 

obtained from the “Define” ribbon tab. They can be 

copied and pasted to Excel spreadsheets.  

2D Interaction 

diagrams 

Interaction diagrams can be exported in EMF format 

(vector graphics used by Microsoft Word and other 

software). These are PM and MM interaction diagrams 

obtained during checks of single frame elements.  

Interaction curves 

tables 

Tables with point coordinates of interaction curves can be 

copied and pasted to Excel spreadsheets. They can be 

obtained clicking the “Copy” button during checks of 

single frame elements.  

Export of complete 

input and output 

data tables 

From the “File” menu by clicking the “Export” button, 

complete data tables for the model, including internal 

forces as well as design and check results can be exported 

to Excel or XML files. Note that these results occupy a 

single, very large worksheet.  

Screen catches Screen catches of reinforced sections, 3D interaction 

diagrams, color-coded graphics of results, Ellipses of 

Inertia, and all other figures generated by VIS, can be 

obtained using the Alt-Stamp button combination from 

the keyboard. 
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